Setting Up Your Printer

This chapter introduces the Apple Color StyleWriter 4500 printer and
explains how to set it up. After you follow the instructions in this chapter,
youll be ready to print.

Important safety instructions

Always take the following precautions:

= Keep the printer cover closed when printing.

= Always turn off the printer before unplugging it.
= Keep theink cartridges away from children.

= Keep the printer away from sources of liquid, such as wash basins,
bathtubs, and shower stalls.

» Protect the printer from dampness or wet weather, such as rain and snow.

s Read all the installation instructions carefully before you plug the printer
into awall socket.

= Keep these instructions handy for reference by you and others
= Follow all instructions and warnings dealing with your computer system.

= Dornt use devices that produce open flames, such as Bunsen burners, near
the printer.
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Dorl't use alcohol-based or ammonia-based cleaners on or around the
printer.

Always unplug the printer before cleaning it. (Use only the cleaning
procedure recommended in Chapter 4)

Clean the outside of the printer with a damp cloth and, if necessary, amild
soap or detergent. Be careful not to get liquid into the printer or the power
cord receptacle

IMPORTANT The only way to disconnect power completely is to unplug the
power adapter. Make sure at least one end of the power cord is within easy
reach so that you can unplug the Color StyleWriter 4500 when you need to.

Watch for these situations, and if one occurs pull the plug!

the power cord or plug becomes frayed or otherwise damaged
you spill something into the printer

the printer is exposed to rain or any other excess moisture
the printer has been dropped or otherwise damaged

you suspect that your printer needs service or repair

WARNING Electrical equipment may be hazardous if misused. Operation
of this product, or smilar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle any cables.



Unpacking the printer

1

2

Remove everything from the shipping box, but leave the ink cartridges in their packages.

Floppy disk Color StyleWriter 4500

Ink cartridge
storage case

Power adapter

Remove the tape and packing material from the outside of the printer.

Setting Up Your Printer
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Open the printer's cover and remove the packing material from the inside of the printer.

Remove the packing material.

Save the carton and the packing material in case you ever need to ship
the printer.

Close the printer’s cover.
Place the printer in your work area.

Choose alocation near your computer that has an electrical outlet and good
ventilation, is out of direct sunlight, never gets damp or very hot or very cold,
and is away from devices that could cause el ectromagnetic interference, such
as stereo speakers or cordless telephone transmitters. Do not place the printer
on adanted surface See Appendix A, “Technical Information,” for specific
information about the physical regquirements of your printer.

IMPORTANT Dorit accidentally discard the ink cartridge storage case You heed
it to store an opened cartridge that youre not using in the printer. The case
keeps the print head from drying out and prevents accidents with ink stains.



Plugging in the printer

Plug the connector end of the power adapter into the printer and then plug the
other end of the adapter into an outlet.

IMPORTANT The only way to disconnect power completely is to unplug the
power adapter. Make sure that at |east one end of the power cord iswithin
easy reach so that you can unplug the printer in an emergency.

WARNING The Color StyleWriter 4500 is designed to work with the
electrical system of the region in which you purchased it. It works with
only one frequency of electricity, either 50 or 60 Hz. The label on the
adapter you received with your printer indicates the frequency required.

The label on the adapter also indicates the voltage required. If you are
using the printer in aregion with a different voltage but the same
frequency as that listed on the adapter, you must use a voltage converter
to provide the voltage indicated on the adapter label.

Serious damage to the printer will result from using the Color
StyleWriter 4500 adapter with an improper electrical frequency or
improper voltage converter. Damage resulting from such misuse of the
printer is not covered under warranty.

Setting Up Your Printer
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Connecting the printer directly to your computer
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You can connect the printer directly to your computer with a serial cable If
you want to add the printer to a Local Talk network, see the next section,
“Connecting to a Local Talk Network.” You cannot connect the printer both
ways.

Plug the cable into the interface port on the printer.

You can use the serial cable that came with your printer, or you can use a
LocalTalk kit and plug a Local Talk cable into the same port.

Some Macintosh
computers have a
combined serial port
with two icons.

Connect this end of the cable
to either the printer port or
the modem port, which are
labeled with these icons.

Plug the other end of the cable into the printer port on your computer.

If your computer is connected to a network, a network cable may already be
connected to the printer port (&). In that case, use the modem port (%).

Remember which port on the computer you use. Later you must tell the
printer software where to ook for the printer.

Some PowerBook computers that have an internal modem installed cannot
tell that the printer is plugged in. You must change a setting in the PowerBook
Setup or Express Modem control panel. For details, see “Special Information
for PowerBook Owners’ in the section “Telling Your Computer to Use the
Color StyleWriter 4500 later in this chapter.



Connecting to a LocalTalk network (optional)

If you have an existing Local Talk network, you can add your printer to it and
share the printer with other Mac OS-based computers on the network.

IMPORTANT You can either connect the printer directly to your computer with
aserial cable or connect it to a Local Talk network with aLocal Talk
connecting kit. You cannot connect the printer both ways at the same time

1  Obtain a LocalTalk connecting kit.

Local Talk connecting kits come in many varieties. A kit usually contains one
connector box and one Local Talk cable Two Local Talk connecting kits are
available from Apple For information about these kits, see “Apple Printer
Supplies and Accessories’ in Appendix A.

2 Plug the connector box into the interface port on the printer.

3 Connect the printer to the network in one of these two ways:

= 10 connect the printer to the end of a Local Talk network, use the Local Talk
cable to connect the empty socket of the nearest devices connector box to
the printer's connector box.

= 0 connect the printer between two devices on a Local Talk network,
disconnect one Local Talk cable from the connector box or the device
immediately to the left or right of the printer and plug it into the new
printer's connector box. Then use the new Local Talk cable to connect the
free socket on the printer's connector box to the socket you freed on the
other devicés connector box.

Setting Up Your Printer
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Turning the printer on and off

To turn on the printer, press the power button. The green power light glows

To turn the printer off, press the power button again. The power light goes out.

Resume button

Power button

WARNING Except in an emergency, make sure the printer is turned off
before you unplug it. (When the power light is off, the power is off) If
the printer is plugged into a power strip, never turn off the power strip
unless youive aready turned the printer off.

When you turn off the printer, it moves the ink cartridges to the right,
where it caps the nozzles to keep the ink cartridges from drying out. If
you unplug the printer or discontinue power before turning it off, the
printer cart position the cartridges in the capped position, the print
head may dry out, and you Il have to replace the cartridge

Power Macintosh users and virtual memory

Chapter 1

If you are using a Power Macintosh computer, you may want to turn on
virtual memory before you try to print on the Color StyleWriter 4500. Then
choose a setting that's at least 1 MB higher than your “Available built-in
memory.” (You can set it higher without any ill effects) With this setting, you
will avoid some potential printing problems. Turning on virtual memory also
reduces the amount of memory needed by many applications. For instructions
on turning on virtual memory, see the documentation that came with your
computer.



Installing the ink cartridges

Each ink cartridge contains a print head, which sprays the ink onto the paper.
Treat it gently so you don't damage its tiny nozzles.

WARNING The carrier holds the ink cartridges and moves them back and
forth when you are printing a document. Dorit dide the carrier by hand
or you will damage the printer.

1  Toturn on your printer, press the power button.
The power light comes on.
2 Open the front cover.

The carrier moves to the center of the printer, and the resume light flashes.

When you turn on the power and

/f/ open the cover, the carrier moves

to the center. Do not slide the
carrier by hand.

Note: If the carrier does not move automatically to the center, try closing the
cover and turning the power off. Then repeat steps 1 and 2.

WARNING Use only ink designed for use with the Color StyleWriter 4500.

Setting Up Your Printer



3 Grasp each ink cartridge by its sides and carefully remove the tape from the cartridge’s
print head.

You may safely touch the colorful caps or the black plastic, but be careful not
to touch any other part.

Make sure you

remove the tape
from both
cartridges.

Note: Open the color and black
ink cartridges. Set the color
PhotoGrade cartridge aside,
still in its protective packaging.
Use it for special projects, not
day-to-day printing.

4 Slide the ink cartridges down into the carrier, and then press both cartridges into place.

For the printer to work, you must install two ink cartridges.

Black ink cartridge

When you install the color PhotoGrade ink
cartridge, it goes into this side of the carrier,
(replacing the black ink cartridge.)

Press until you hear a snap, and
the cartridge fits snugly in the
carrier. It should be difficult to
remove. If a cartridge feels loose,
it is not properly seated.

.

10 - Chapter1



5  Close the printer’s front cover.

When you close the cover, you can
hear the carrier move to the right.

Important: If the resume light
blinks after you close the cover,
the ink cartridges are not
installed properly.

Turn the printer off, then repeat
steps 1 through 5. Be sure to
press both ink cartridges firmly
into place in the carrier.

Storing the ink cartridge you aren't using

The Color StyleWriter 4500 comes with color, black, and color PhotoGrade
cartridges. Sealed in their original packaging, the cartridges are protected. If
you open all three packages and switch between the black and PhotoGrade
cartridges for printing different documents, be sure to store the one youre not
using in the storage case supplied with your Color StyleWriter 4500. The
storage case keeps the print head from drying out and prevents accidents with

ink stains.
Black ink <. _Color PhotoGrade
cartridge g ink cartridge
AN
(N
]
‘ Note: The cartridges face in different

directions when properly inserted in
the storage case.

Keep opened ink cartridges inside the
printer or in the storage case.

IMPORTANT If you are using only two cartridges, leave them inside the printer.

Setting Up Your Printer
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Installing your printer software
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Before you can print your documents, you need to install the printer software
on your computer. The Apple Printer Software Collection CD-ROM that comes
with the Color StyleWriter 4500 contains the printer software and an I nstaller
program.

The Installer installs the new printing software you need, plus the fonts that
come with the printer (see Appendix C for alist of available fonts).

If you have been using Applés special QuickDraw GX software, turn it off
now. The Color StyleWriter 4500 is not compatible with QuickDraw GX.

Note: If you ever upgrade your system software (for example from System 71
to System 75), you must reinstall the Color StyleWriter 4500 software:

Using the Minimal Printer Software floppy disk

If you have a CD-ROM drive skip to the next section, “Using the Apple
Printer Software Collection CD-ROM”

If you do not have a CD-ROM drive, the Color SyleWriter 4000 Series Minimal
Printer Software floppy disk that came with your printer contains minimal
software that lets you start printing now. For instructions on installing the
software, see the Read Me you |l find on the floppy disk.

In addition, you can contact Apple and ask to have the complete Color
StyleWriter 4500 printer software mailed to you on a set of floppy disks. If
you prefer not to wait and have access to a computer with a CD-ROM drive,
the Apple Printer Software Collection CD-ROM contains disk images of the
complete set of floppy disks. The CD-ROM also contains a disk-duplication
application you can use to create your own set of floppy disks. See the
instructions that accompany the application.

Note: The minimal printer software works with a Color StyleWriter 4500
printer that is connected by a serial cable to your computer. If you want to use
aLoca Talk kit to connect the printer, you must use the software that comes
on the complete disk set.

Now you can go on to read the section “Telling Your Computer to Use the
Color StyleWriter 4500, later in this chapter.



Using the Apple Printer Software Collection CD-ROM

Turn off any automatic virus-detection applications you have on your Macintosh
computer.

If you dont, problems may occur during the installation. After installation
is complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection application, see the manual
that came with the program.)

Insert Apple Printer Software Collection CD-ROM into your CD-ROM drive.
Open the Printer Software folder.

You may have to open the CD icon to see the Printer Software and Software
Collection folders

Open the Installer folder (inside the Printer Software folder).
To start the Installer program, double-click its icon.

In the Welcome dialog box that appears, click Continue.

IMPORTANT The Installer determines whether you have the correct system
software, and enough memory and hard disk space to use this printer. If you
dorit, the Installer displays a message telling you what you need. You wont be
able to install the printer software until you correct the system software or
memory problem. If the message reports a problem, you can purchase new
system software or memory from an Apple-authorized dealer, or make space
available on your hard disk by throwing away files you dorit need.

Read the software license agreement and click Agree.

If you are unwilling to accept the terms of the agreement, click Disagree

Setting Up Your Printer
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Make sure the disk
named here is the
one on which you
want to install the

printer software.

(If not, click Switch

Disk until the correct
name appears.)

9
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In the Installer dialog box, click Install.

——————r———————— Installer Stript ==="—————F————=—"o015
[ Easy Install b |

Color StylelWriter 4000 Series software

------ Destination Disk

fient fisk When you’re ready to
*four Hard Disk m— begin, CliCk InSta”-

[@

After afew moments, the Installer begins to install the printer software A
status box keeps you informed of progress during installation.

When you see a message reporting that installation was successful, click Restart.



Installation troubleshooting

If the Installer can't complete the installation, it will issue a warning message
Here are some ways to fix common problems:

= You may not have the correct hardware or system software for this printer.
If so, the Installer will tell you what youre missing.

= You may have forgotten to turn off your virus-detection software as
described in the section “Using the Color SyleWriter 4500 CD-ROM,”
earlier in the manual.

= You may have some corrupted fonts on your hard disk. To solve this
problem, see “Installation Is Unsuccessful” in Chapter 5

More information about the Installer program

In the procedure just described the Installer copies all the software you need
to your hard disk. In rare circumstances you may want to copy only a subset
of the software. In that case choose Custom Install from the pop-up menu in
the Installer. When alist of choices appears, select the items you wish to
install, then dick the Install button. (Click the letter i to the right of any of
the choices for information.)

Setting Up Your Printer

15



16

Telling your computer to use a directly connected Color StyleWriter 4500

Chapter 1

If your printer is connected directly to your computer with a serial cable,
follow these instructions for selecting it in the Chooser.

If your printer is connected to a Local Talk network, see the next section,
“Telling Your Computer to Use a Color StyleWriter on a Local Talk Network.”

Make sure the printer is turned on.

Select Chooser from the Apple (6) menu.

In the Chooser dialog box, click the appropriate items to select them.

First, click this icon.

(If necessary, use the scroll

bar and arrows to find it.)

s§F=———— Chooser

CEW 4000 jes (AT)

Mack25

Lazeriwriter

<

<l

Select a printer port:

=

)
%

=

3y Dackground Printing
om0 0rt

) Active

AppleTalk @ Inactive

Then click one of these
items to indicate which port
you connected the printer to:
the printer port (&) or the
modem port ().

If no port is available

and your computer is a
PowerBook, see “Special
Information for PowerBook
Owners,” later in this chapter.

Close the Chooser by clicking the close box in its upper-left corner.



Telling your computer to use a Color StyleWriter on a LocalTalk network

First, click this icon
(If necessary, use the
scroll bar and arrows
to find it.).

The “AT" stands for
AppleTalk.

Make sure the —

StyleWriter 4500
shows in this pop-up
menu.

You can connect a Color StyleWriter 4500 printer directly to aLocal Talk
network.

Note: If you do not need to share the printer with other users on the network,
connect the printer directly to your computer with the serial cable The
printer prints faster when connected this way.

Once the printer is on the network, its name appears in the Chooser just like
the names of other network printers

El Chooser

Select a Stylewriter:

Annh’s Printer
Carol’s Color Printer
CS'w on Network

o>

F__T
=]

Second, click the name of

FEH 4000 Sertes your printer on this list.

AppleShare

Diane’s Office Printer
Don's CSw

Larry’s Department Printer
Marie’s Test Printer
Randy’s Color

Ray’s Market Printer

AppleTalk Zones:
Halftime

Hardware Test Lab Sue’s World Printer

Imaging 7]

Instructional Products ’ % Background Printing

Japan @® On (3 0FF

Maontana

Second Floor aopleranc ® Active L Finally, click to make
Third Floor PRIETEE . Ginactive AppleTalk active.

If you want to change the name, click Setup in the dialog box that appears,
type a new name, and cdlick Rename (Note: Anyone on the network can
change the name)

Printer 5etup

————1
Type: [ StyleWriter 4500 « |
vome: RO (foroms)—|— 1y 2 rew name, ther

click Rename (or press Return).

Setting Up Your Printer
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Special information for PowerBook owners

PowerBook computers that have internal modems may require special setups
What you do depends on whether the Powerbook has one or two seria ports
on its back panel.

Note: Thisinformation is for PowerBook users who connect the printer
directly to their computer with a serial cable

PowerBook computers with one serial port

Some PowerBook computers have a single serial port identified by a
combination printer/modem icon (&/%). If an internal modem isinstalled on
one of these PowerBook computers, the serial port may be in use even though
it looks available When you plug in the Color StyleWriter 4500, the
PowerBook may not be able to communicate with the printer.

To make the port available for printing, make sure the serial port setting is
Normal or External. To check the setting, open the PowerBook, PowerBook
Setup, or Express Modem control panel. (If you have another kind of internal
modem, you may have a different control panel. The control panel and the
setting you use depend on which PowerBook you have and which internal
modem you have) If you have a PowerBook Express Modem, it is best to
leave the serial port setting as Normal or External unless the modem
programs you use require another setting for compatibility reasons

PowerBook computers with two serial ports

Even when a PowerBook has two serial ports, if it also has an internal
modem, the modem port (&) may look available but actually bein use If the
printer port (&) is available, connect the Color StyleWriter 4500 to it. If the
printer port is unavailable and you must use the modem port, make sure the
modem serial port setting is Normal or External. To check the setting, open
the PowerBook, PowerBook Setup, or Express Modem control panel. (If you
have another kind of internal modem, you may have a different control panel.
The control panel and the setting you use depend on which modem and
system software version you have) If you have a PowerBook Express Modem,
it is best to leave the serial port setting as Normal or External.

For more information, see the instructions that came with your PowerBook.



Loading paper into the paper tray

The paper tray holds up to 100 sheets of 20-pound paper and feeds the paper
automatically into the printer. You can load many sizes of paper and other
media into the sheet feeder as described in Chapter 2, but to align the ink
cartridges, as described in the next section, you must use U.S letter-size or
A4 paper. To load paper into the sheet feeder, follow these steps:

1  Slide the paper adjusters out as far as you can.

Length adjuster

Make sure the paper selection
lever is all the way to the left.

2 Make sure the edges are even on all sides before inserting a stack of paper.

Setting Up Your Printer
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3

4

Load the paper into the lower tray, print side down.

The wrapper that the paper comesin usually tells which side to print first.

Slide the paper lengthwise
into the tray, print side down.

Note: Illustrations inside the printer cover remind you how to insert paper
and envelopes correctly.

Slide the paper adjusters in to touch the edges of the stack of paper.




Aligning the ink cartridges

Click Start.

Whenever you install a new ink cartridge, follow these steps:
If necessary, turn on the printer.

The green power light should be on.

IMPORTANT If the resume light blinks, the ink cartridges are not installed
properly. Turn the printer off. Then follow the stepsin “Installing the Ink
Cartridges” earlier in this chapter.

Make sure there is plain paper in the paper tray.
Choose Page Setup from the File menu.

In the Page Setup dialog box, click Utilities.

Two-5ided Printing:

Ol Flip Horizontal [(None  ~]

[JUse Color PhotoGrade Ink Cartridge
[ save as Default

Color Stylellriter 4500 Page Setup
Paper Size: Paper Type:
[ US Letter +] [ Plain Paper |
utiliti Click Utilities.
Orientation: scaling (%) @

In the dialog box that appears, find Align Print Cartridges and click Start.

Color StylellUriter 4500 Utilities

Clean Print Cartridge: Cancel

Align Print Cartridges:

Read the message that appears, and click Align.

The following process aligns the patterns of

ink placed on the page by both print

cartridges.

We recommend that you align the cartridges
edach time either cartridge is replaced.

| Click Align.

Setting Up Your Printer
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7  Examine the patterns that appear on the printed page.

From among the sets of parallel lines, choose the horizontal set and the
vertical set for which the black and magenta lines are most closely aligned.

IMPORTANT If you cannot see black lines, make sure you have removed the
tape from the black ink cartridge If you cannot see magenta lines, remove the
tape from the color ink cartridge

8 Inthedialog box that appears, click the number and letter corresponding to the best
aligned sets, and click OK.

Your printer has printed two sets of alignment

patterns. Look at each pattern carefully.
Choose the best aligned pattern, for each set,
then select the corresponding buttons below.

1 D2 O3 O4 O5 06 09 08 09 21001

OR OB OC OD OF OF 06 OH O1 Od OK

The printer prints a second page, containing a square and a cross, for you to
verify that the alignment is acceptable

9  If the patterns on the second printed page are acceptable, click OK.

The alignment procedure is complete. Your

printer has printed a square and cross

pattern.

Exdamine each pattern to ensure that all
black and magenta segments line up. If they
do not, run the alignment process again.

(Thiign_| | If the square and cross are
properly aligned, click OK.

To repeat the process, click Align.

10  Click OK in the remaining dialog boxes.

You have finished aligning the ink cartridges in your printer.

Chapter 1



Printing the sample page
To see what your printer can do, print the demonstration page
1  Make sure the printer and computer are turned on.

2  Press and hold down the resume button for three seconds and release it.

Make sure the
paper selection
lever is all the
way to the left.

The printer prints the sample page, your first full-color document from your
new printer.

-
Color StyleWriter 4500
.F__r;f'f- Note You do not need to print this page
'J'_L:._';’a'-' \ every time you use the printer.

Setting Up Your Printer
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Using onscreen help

The CSW 4000 Series Printer Guide is a valuable source of information
about your printer and printer software The Guide menu is identified by a
question mark (@) in the upper-right corner of the screen.

=] G

About Apple Guide

Show Balloons

Macintosh Guide )
Shortcuts

CSW 4000 Series Printer Guide_— Choose this.

To open CSW 4000 Series Printer Guide, make sure you are in the Finder.
Then choose CSW Guide from the Guide (@) menu at the top of your screen.

Macintosh (or Mac OS) Guide also contains general information about
printing, as well as other information about using your computer. Macintosh
Guide is available while youre in the Finder.

CSW 4000 Series Printer Guide provides onscreen help on how to use your
printer.

[m]

Color StyleWriter
Secies
Printer Guide

Index

Look For

First, click the Topics
button

Second, choose
a topic from the list
that appears here.

Chapter 1

1. Click = topic area:

Z.Click a phrase, then click O

[T {5etting Up 43
Selecting & Configuring a Printer

Printing on Different Paper
Managing Background Printing
Using Ink Cartridges

Printing Tips

|| | Troubleshooting

= How dol
reduce ar enlarge a docurment?
change a document’s orientation?
print a horizontally flipped image?
print rmultiple copies?
print pages in reverse order?
print on both sides of the paper?
print in grayscale?
change print quality?

change the default Page Setup settings?

= Definitions

AppleTalk

Third, for detailed
instructions, select
the question you want
answered from this list
and click OK.



Tips for using CSW 4000 Series Printer Guide
When you can't find the information you need

» Insearching for help topics, use al three buttons at the top of Guidées
initial window: Topics, Index, and Look For.

= If yourein aseriesof stepsand want to return to the list of help topics,
dick the button marked Topics in the Guide window.

When you can't see what’s behind the Guide window

Guide windows stay in front of other windows on the screen so that your
instructions are never covered.

» Drag a Guide window by itstitle bar to move it out of the way.

» Click the zoom box once to shrink a guide window. (To expand the
window, click the zoom box a second time)

When you need more information about an instruction or term
= Click the “Huh?’ button if it is available

» |f an unfamiliar word is underlined, click it to get a definition.

T EJ— Zoom box

background printing

Title bar —

Background printing lets you print docuinents while
Viou uge vour cormputer for other work, You turn this
feature on or off in the Chooser,

Read this information, then vou're done,

Topics button Navigation buttons

Setting Up Your Printer
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Using the electronic user’s manual

Chapter 1

This setup manual also appears as Chapter 1 in an electronic user's manual,
along with the complete reference information about your printer. the
electronic manual, in Adobe Portable Document Format (PDF) is available
on the apple Printer software Collection CD-ROM.

On the CD-ROM, open the Printer Software folder and find the Electronic Manual folder.
Drag the Electronic Manual folder to your hard drive.

Double-click the Electronic Manual folder to open it.

Double-click the Installer

Follow the instructions on the screen to install Adobe Acrobat™ Reader.
When installation is complete, double-click the CSW Manual.pdf file to open it.

Now you can read the manual on your computer screen.

Tips for finding and printing information with Acrobat Reader

Adobe Acrobat Reader has features that give you fast, easy accessto
information.

= For help using the Acrobat Reader, choose Acrobat Reader Help from the
Help (@) menu at the top of your screen. The Adobe Acrobat Reader
Online Guide appears.

= Print only specific sections fo the manual that contain information you
need. Printing an entire PDF file can be a time-consuming task and can
use large amounts of ink and paper unnecessarily.



Printing

This chapter explains how to use the Color StyleWriter 4500 for everyday
tasks Before you follow the instructions in this chapter, make sure the printer
is set up and working, as described in Chapter 1

Planning documents with the Color StyleWriter 4500 in mind

Many printer options affect how much can fit on a page Before you spend a
lot of time laying out a document, set it up as you plan to print it:

1  Select the printer you plan to use.

If the Color StyleWriter 4500 is your only printer, and you followed the setup
instructions in Chapter 1, you have selected your printer. If you have access to
more than one printer, see “Switching Between Printers” later in this chapter.

2 With the document active on your computer screen, choose Page Setup from the File
menu and select the options you like.

The key areas that affect page layout are paper size, type, and orientation.

When youive finished setting your options, click the OK button to return to
your document. You can now format it as you like Since youve already set
your printing options, the document will print as you see it on your screen.
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Printing a document

Chapter 2

The next two sections explain the different ways you can print a document:

m Quick instructions for printing standard documents. To print documents that
don't require any special options, see this section. (The section describes
what a “standard document” is)

m Detailed instructions for printing other documents. To print documents that
require any of the nonstandard options, see this section.

Quick instructions for printing standard documents

To print a standard document, follow the instructions in this section:
» Standard paper size, US Letter (85" by 11" in the United States)
= plain paper

= portrait page orientation (so when you look at the printed page, it is longer
than it iswide)

= no special effects and normal print quality
Assuming you have already selected the printer in the Chooser as described

in Chapter 1, and that the printer isfilled with standard paper, you need only
follow these steps:

While the document is in an active window, choose the Print command from the
File menu.

The Print dialog box opens on your screen.
Make sure the printer is turned on (the green power light glows).
Click the Print button.

After afew moments, the document startsto print. If background printing is
turned on, you can continue working while the document is printing. You can
also monitor and control the documents that are waiting to print. (See
“Printing While You Use Your Computer” and “Monitoring and Controlling
Background Printing,” later in this chapter)



Detailed instructions for printing documents
If your document is not standard, follow these steps:
1  If you haven't already selected the Color StyleWriter 4500 in the Chooser, do so now.

You already selected the Color StyleWriter 4500 in Chapter 1, and if it's the
only printer you ever use, you worit need to do it again. If you do need to
switch, see “Switching Between Printers,” later in this chapter.

2  Loadthe paper, envelopes, or other materials into the printer, as described in Chapter 1.

Remember to adjust the external paper selector before filling the sheet feeder.

3 While the document is active on your screen, choose Page Setup from the File menu and
make adjustments in the dialog box that opens.

If the default settings shown here are satisfactory, you can skip this step.

To indicate the size

and type of paper in E::’errs;ii':_“""” 4500 Paﬂz:::;‘zpe_ - Choosi the ls_elitig?(S you
: : want, then click OK.
i the paper tray, use [ us Letter ¥] [ Plain Paper |
ese pop-up menus. T T
Pop p . Orientation: Scaling (%)
To print with a
PhotoGrade cartridge Two-Sided Printing:
in the printer, click to [ Flip Horizontal [(None _+]
put an X in this box. —| ] use Color PhotoGrade Ink Cartridge
[ Save as Default
(You may also want
to choose Photograde
from the Paper Type For manual duplex printing You can type a number from 25 to 400.
pop-up menu.) (two-sided), use this pop-up menu. Numbers smaller than 100 reduce the image;

numbers greater than 100 enlarge it.
Changing the size may change the pagination.

For more information about optional features, see “Adjusting Color Options
later in this chapter.

IMPORTANT Make sure you correctly indicate the size of the paper, envelopes,
or other material you have in the paper tray. If you change the paper sizein
this dialog box, you might also want to look over your document to see if any
of the page breaks have changed. For information on non-standard sizes, see
“Defining Your Own Custom Paper Sizes” later in this chapter.
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4 Choose Print from the File menu and make adjustments in the dialog box that opens.

Best quality takes Color St " ;
. ylelriter 4500 i | Choose the settings you
longer to print. — - SELings y
i Quality: Pages: want, then click Print.
Draft is faster. [ Normal v ] @ AN
) From: To: Preview —— To see how your page
copies: ) will look when printed,
To pfint color images — [ Print in Grayscale Print Back to Front click Preview.
in black and white T
and grayscale,
click to put an X |
in this box. If you want your printed pages to be stacked
in the correct order as they come out of the
printer, click to put an X in this box.
Item in dialog box What you use it for
Quality Select which level of quality you want. Generally, the higher the quality, the

longer the document will take to print. The Draft option is available only
when you use Plain paper or Transparency.

Pages Indicate how many pages of the document to print. To print the whole
document, click All. To print a range of pages, type the beginning and end
page numbers.

Copies Type how many copies of the document you want.

5  Click the Print button.

After afew moments, the document starts to print. If background printing is
turned on, you can continue working while the document is printing. You can
also monitor and control the documents that are waiting to print. (See
“Printing While You Use Your Computer” and “Monitoring and Controlling
Background Printing,” later in this chapter)
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Printing while you use your computer

Click this icon.

You can continue to work on your computer while printing on the
Color StyleWriter 4500. The feature that gives you this ability is called

background printing To turn background printing on or off, follow these steps:

Select Chooser from the Apple (6) menu.
Click the CSW 4000 Series icon in the Chooser.

If your printer is connected to your computer by a Local Talk connection kit,
click the CSW 4000 Series (AT) icon.

Y

AppleShare

If you don't see the
-l Lo icon, click this arrow
CEW 4000 ..jes (AT)  LaserWriter [ until it appears.

Click to turn background printing on or off.

f———————— Background Printin
ST
i dctive
@ Inactive

Click On or Off.

AppleTalk

Click the close box in the upper-left corner of the Chooser.

Once background printing isturned on, it isin effect whenever you print,
until you turn it off. When you cdlick Print in the Print dialog box, a message
appears for amoment to tell you the document is being prepared. Once the
message disappears, you can continue other work. Your computer may pause
occasionally while it processes the document for printing. See “Monitoring
and Controlling Background Printing,” next, for more information.

Note: Printing may be dower with background printing on. If you turn
background printing off, however, you must wait for printing to finish before
you can continue your work. Any time you print with the color PhotoGrade
cartridge on PhotoGrade paper, you should turn off background printing.
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Monitoring and controlling background printing

If you are using background printing, you can use the PrintMonitor to check
on and control your print requests. (To turn background printing on and off,
see “Printing While You Use Your Computer,” earlier in this chapter,)

1 While printing is in progress, choose PrintMonitor from the Application menu.

oK

Hide SimpleText
Hide Others

Finder
[ cSW 4000 Series PrintMonitor-}— Choose PrintMonitor.
w4 SimpleText

A window opens listing the documents that are printing or waiting to print:

E[I==——=— PrintMonitor The document that's
Printing

[ LiTesler Interview @ CSw 4000 Series  ——H— currently printing
Waiting

1 O, Pwr Mac systems @ CSW 4000 Series

2 [, Memo @ CSW 4000 Series

Documents waiting to print

=
[ cancel Printing }———— To cancel a job that's printing (or one
Printing Status: Tesler Interview that's Waltlng to p”nt)yseleCt the JOb
page 1 of 4; printing 1& complete {sending data) and click here.

2 You can check the activity on your printer and cancel printing if you want to.
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Adjusting color options
To adjust the way colors are printed, follow these steps:
1  Choose Print from the File menu.

2 Inthedialog box that appears, click Options.

Color StylelWriter 4500
Quality: Pages:
C 1
@ —
) From: To: Preview
copies: [N | Click Options.
[1Print in Grayscale [ Print Back to Front

3 Select your color options.

Unless you have specific needs, it may be best to leave the settings on Auto.

Color StylelWriter 4500 Options ok H— For information about color
Intensity: Color Matching: op[ionsl choose CSW 4000
Auto ] [(cancel] Series Printer Guide from

Halftoning: Bleed Control: Help the HeIp (@) menu.
For information on using

Guide, see Chapter 1.

The ColorSync color-matching system makes sure that colors look as
consistent as possible no matter what device you use to view them—monitor
or printer. In addition, ColorSync helps give you the best possible colors
when you export the image to another Mac OS—based computer with
ColorSync installed or print it on another color printer.

Note: For the best color, you need to choose a specific profile for your
monitor. In the ColorSync control panel, choose the D50 prafile for your
monitor. If there is no D50 available for your monitor, choose Apple Multiple
Scan 17 — D50. The D50 profile gives you better colors.

For more information on ColorSync, see Appendix C.
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Printing a photograph

Chapter 2

You can print exceptional quality photographic or other color images, using
the color PhotoGrade ink cartridge

= Use the color and color PhotoGrade cartridges to print color and black-
and-white photographs or pictures with vivid colors

» Use the color and black cartridges for black text, documents that are
mainly text, banners, and pictures other than photographs

Put paper in the lower paper tray, print side down (as usual).

If youre using Apple Color Ink—Jet Color PhotoGrade paper, the package tells
you which side to print on. You can use plain paper to print photographs. For
best results, use PhotoGrade paper.

IMPORTANT Before you print using the color PhotoGrade ink cartridge and
color PhotoGrade paper, be sure to turn off background printing. With
background printing on, the printer experiences small delays when the
computer is busy with something else The resulting print quality may not be
the best you can get from your Color StyleWriter 4500.

Turn on the printer.

The green power light should glow.



3

4

5

Open the top cover.

The carrier moves to the center of the printer. The resume light flashes

Remove the black ink cartridge.

To pop the cartridge loose,
pull its top toward you.
Then it it out of the carrier.

Printing
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6

Slide the color PhotoGrade ink cartridge down into the carrier, and press it into place.

Note: The color PhotoGrade ink cartridge
includes specially formulated black and
color inks for photorealistic printing.

Close the printer’s cover.

The carrier returns to its home position on the right side of the printer, and
the resume light stops flashing.



8  Choose Page Setup from the File menu.

Color Stylelriter 4500 Page Setup ok H— Choose the settings you
Paper Size: Paper Type: - want, then click OK.
[0S Letter +
Transparency -m
Orientation: Coated Paper
Iy Gl
. (] 1wl Photobrade Choose the paper that
Click to putan X ~ ] suits your purposes
. . one v :
in this box. — Il Fiip norizontal For the best quality
[ Use Color PhotoGrade Ink Cartridge put PhotoGrade paper

[ Save as Default

into the paper tray
and choose it here.

9  Choose Print from the File menu.
10 Inthe dialog box that appears, click Print from the File menu.

The document containing the photographs beginsto print. It may take several
minutes before you can see the results

When you're done printing photographs

Take the time to reset the printer for normal printing. Here are some settings
to remember:

= Takethe color PhotoGrade ink cartridge out of the printer, put it into the
storage case, and put the black ink cartridge back into the printer.

= In the Page Setup dialog box, change Paper Type back to Plain Paper (if
that's what you plan to use next). Click the Use Color PhotoGrade
Cartridge checkbox to remove the X.

» Remove any special paper from the lower paper tray, and replace it with
plain paper.
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Printing a banner

1
2

Choose one of the __|
banner paper sizes.

For the best results, use Apple Color Ink—Jet Banner Paper. If you use
continuous computer paper or Z-fold paper instead, 20-pound paper is best.

Choose Page Setup from the File menu.

In the Page Setup dialog box, choose either Banner US Letter or Banner A4 from the
Paper Size pop-up menu.

Chapter 2

A2 Envelope

US Card 446
US Card 5u8
A6 Card

Hagaki Card

Add Custom...
Edit Custom...

Color Stylelriter 4300 Page Setup | Choose the settings you
Paper Size: Paper Type: want, then click OK.
S Letter Plain Paper w
—Banner US Letter m
orj{ US Legal scaling (%): (utiities)
Executive
A4 Two-Sided Printing:
— Banner A4
O as
O BI-JIS nk Cartridge
_D No. 10 Envelope
C6 Envelope
DL Envelope

Note: For information on the sizes
of the banner papers (in inches and
millimeters), see Appendix A.



3

4
5

6

Slide the paper selection lever to the right until it clicks into place.

Anicon on the lever indicates that this is the setting for banner paper.

Paper selection lever ‘

Remove all paper from the lower tray.

Flip up the banner support in the upper tray.

Flip up the banner support.

Estimate how many sheets your banner needs to print.

Printing
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Using the application that created the banner, you should be able to tell
whether the banner will cover three sheets or four sheets, for example The
printer prints a maximum of 20 sheets in one banner.

From a stack of Z-fold banner paper, tear off at least one sheet more than you need to
print the banner.

Tear off the perforated strips, if any, and then unfold and refold the stack to make sure
pages don't stick together.

Put this edge into the paper tray first, at the top of the stack

Put the paper in the lower paper tray, with a torn edge at the top of the stack, facing
lengthwise into the printer.

Slide the paper adjusters so they touch the edges of the stack of paper.



11  Make sure the banner document is the active window on the screen, and choose Print
from the File menu.

12  Inthe dialog box that appears, click Print.

13 When printing stops, press the Resume button as many times as necessary to advance
the remaining banner paper out of the printer.

Resume button

When you're done printing banners

Take the time to reset the printer for normal printing. Here are some steps to
remember:

In the Page Setup dialog box, select the Paper Size appropriate for the
document you want to print next.

Side the paper selection lever to the left. (The lever islocated underneath
the left corner of the lower paper tray)

Lower the banner support in the upper tray.
Put some paper into the lower paper tray.

Printing
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Printing envelopes

If youre printing a single envelope, use the single-envelope dot (and leave the
paper in the paper tray). If youre printing a stack of envelopes, use the

paper tray

Notes about envelopes

See the instructions that came with the applications you use to see if they
offer special, easy ways to format and print envelopes. If not, choose the
envelope size youre using in the Page Setup dialog box and format the
envelope text asyou like

IMPORTANT The Color StyleWriter 4500 cannot print flush with the left edge,
so return addresses may print closer to the center than you like To avoid the
problem, use envel opes preprinted with your return address, or put the
address on a label or arubber stamp.

Single business-size envelopes
1  Choose Page Setup from the File menu.

2  Inthe Page Setup dialog box, choose either No. 10 Envelope or DL Envelope from the
Paper Size pop-up menu.

Color StylelWriter 4500 Page Setup | Choose the settings you
Paper Size: Paper Type: want, then click OK.
Banner US Letter
ori¢ US Legal Scaling (%):
Executive
A4 Two-5Sided Printing:
O as
O Ba-JIs nk Cartridge
O
No. 10 Envelope
Choose No.10 —_{Eﬁ Envelope
Envelope DL Envelape
or DL Envelope. A2 Envelope Note: For information on the sizes
US Card 446 of the envelgpes (ininches and millimeters),
US Card 518 see Appendix A.
A6 Card
Hagaki Card
Add Custom...
Edit Custom...
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Slide an envelope into the single-envelope slot until it stops.

Load the envelope print side
down, with the flap against
the right side of the printer.

Important: Make sure there
is paper in the tray.

Choose Print from the File menu.

If you are using an application that includes settings for printing envelopes,
follow the applicatioris instructions for setting up the address and placing the

envelope in the printer.

In the dialog box that appears, click Print.

Printing
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A stack of envelopes
1  Choose Page Setup from the File menu.

2 Inthe Page Setup dialog box, choose the envelope you're printing from the Paper Size

pop-up menu.

Color StylelWriter 43500 Page Setup _ |__ Choose the settings you

Paper Size: Paper Type: want, then click OK.
Banner US Letter

ori{ USLegal scaling (%)
Executive
A4 Two-Sided Printing:

O s

O BS-JIS nk Cartridge

n No. 10 Envelope

Choose the envelope L6 Envelope
- DL Envelope . . .
you are printing. A2 Envelope Note: For information on the sizes
of the envelopes (in inches and millimeters),

US Card 446 .
US Card 548 see Appendix A.
A6 Card
Hagaki Card
Add Custom...
Edit Custom...

3 Slide the paper adjusters out as far as you can.

Width adjuster

Length adjuster

The paper tray
should be empty.
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5

Put a stack of up to 20 envelopes in the printer.

If the envelopes are thick, reduce the number in the stack.

Load the envelopes print side
down, with the flap against the
side of the printer.

Printing
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If youre printing small, invitation-size envelopes (such as A2 or C6), you may
have to lower the handle on the length adjuster so you can dide it far enough
under the upper paper tray.

To release the handle so
you can lower it, squeeze
the lower inside surface.

Choose Print from the File menu.

If you are using an application that includes settings for printing envelopes,
follow the applicatior’s instructions for setting up the address and placing the
envelope in the printer.

In the dialog box that appears, click Print.

When you're done printing envelopes

Take the time to reset the printer for normal printing. Here are some stepsto
remember:

= In the Page Setup dialog box, select the Paper Sze appropriate for the
document you want to print next.

» Remove any unused envelopes and make sure there is paper in the lower
paper tray.



Printing transparencies

For best results, use Apple Color Ink—Jet Transparency Film or transparencies
designed for ink—jet printers

1  Choose Page Setup from the File menu.

2 Inthe Page Setup dialog box, choose Transparency from the Paper Type pop-up menu.

Color StylelWriter 4500 Page Setup | Choose the settings you
Paper Size: Paper Type: want, then click OK.
[ USs Letter w| [~Plain Paper

Transparency
Orientation: Coated Paper

Giossy

Twy PhotoGrade

[ Flip Horizontal | Choose Transparency.
[Juse Color PhotoGrade Ink Cartridge
[] Save as Default

3 Choose Print from the File menu.

4 Inthe Print dialog box that appears, choose Best from the Quality pop-up menu.

Color StylelWriter 4500
Choose Best. __| Pages:
[OF ]
) From: To: Preview
Copies:
[ Print in Grayscale O Print Back to Front

Printing
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5

Insert the transparencies into the paper tray, shiny side down, with the joined edge into
the paper tray first.

Load transparencies with the
shiny side down. The edge
where the paper and
transparency are joined should
go into the paper tray first.

Single layer trasparency

Paper-backed transparency

Slide the paper adjusters in so they touch the edges of the stack.
Choose Print from the File menu.
In the dialog box that appears, click Print.

I'n printing transparencies, the printer uses more ink, putsit on the
transparency surface more dowly, and allows more time for inks to dry
between sheets For these reasons, transparencies take a while to print.

When you're done printing transparencies
Take the time to reset the printer for normal printing. Here are some steps to
remember:

= In the Page Setup dialog box, select the Paper Type appropriate for the
document you want to print next.

= Remove any unused transparencies and put some paper into the lower
paper tray.

= Next time you print, remember to change the print quality back to Normal
(or whatever is appropriate) in the Print dialog box.



Printing labels

Choose US Letter
(or A4) and
Plain Paper.

For printing labels,
use Normal print
quality.

For best results, use labels designed for ink—jet printers

Choose Page Setup from the File menu.

In the Page Setup dialog box, choose US Letter or A4 from the Paper Size popup menu,
and choose Plain Paper from the Paper Type pop-up menu.

Color Stylelldriter 4500 Page Setup

Paper Size: Paper Type:
[ usLetter w| [ Plain Paper w]

T T
Orientation: Scaling (%):

Two-5ided Printing:

O Flip Horizontal [(Nome  ~]

[Juse Color PhotoGrade Ink Cartridge
[ save as Default

Cancel

| Choose the settings you
want, then click OK.

Choose Print from the File menu.

In the Print dialog box that appears, choose Normal from the Quality pop-up menu.

Color StylelWriter 4500 -

Quality: Pages:
Normal | @ Al ance

) From: To: Preview

Copies: ::

[1Print in Grayscale [ Print Back to Front

| Choose the settings you
want, then click Print.
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5  Fan the edges of the label sheets to make sure they are separated.

6 Insertinto the paper tray sheets of labels, face-down, on top of about 5 sheets of plain
paper that's the same size.

You can insert up to 25 sheets of labels.

Labels, face-down

Plain paper (5 sheets)

7  Slide the paper adjusters in so they touch the edges of the stack.
8  Choose Print from the File menu.
9 Inthedialog box that appears, click Print.

When you're done printing labels

If you expect to print on plain paper next, you can leave the print settings as
they are
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Printing index cards and postcards

Choose the size that
matches the cards
you are printing on.

3

You can use the Color StyleWriter 4500 to print on index cards and postcards.

Choose Page Setup from the File menu.

In the Page Setup dialog box, choose the card size you want from the Paper Size pop-up
menu, and choose Plain Paper from the Paper Type pop-up menu.

Color StyleWriter 4500 Page Setup _ | Choose the settings you
Paper Size: Paper Type: Cancol want, then click OK.
v US Letter Plain Paper w
Banner US Letter m
ori{ US Legal scaling (%): (utiities)
Executive
A4 Two-Sided Printing:
Banner A4
O ns
O Ba-JIs nk Cartridge
=D No. 10 Envelope

C6 Envelope
DL Envelope
A2 Envelope

US Card 4ub
Us Card 548
A6 Card

Hagaki Card

Add Custom...
Edit Custom...

Note: For information on the sizes
of the cards (in inches and millimeters),
see Appendix A.

Remove the upper tray and raise the card guide.

Remove the upper tray.
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4 Place a stack of up to 30 cards in the lower paper tray, resting against the raised card
guide.

5  Lower the handle on the paper length adjuster.

To release the handle so
you can lower it, squeeze
the lower inside surface.

6  Slide the paper adjusters in so they touch the edges of the stack.
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Replace the upper tray and raise the card guide.

You may need to lift the printer cover for easy access

Choose Print from the File menu.

When you're done printing index cards or postcards

Take the time to reset the printer for normal printing. Here are some stepsto
remember:

= In the Page Setup dialog box, select the Paper Sze appropriate for the
document you want to print next.

» Remove the top tray, then remove any unused cards and lower the
card guide

» Replace the top tray and make sure there is paper in the lower paper tray.
» Raise the paper adjuster handle back to its vertical postion.
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Manual duplex printing (two-sided)

Chapter 2

To conserve paper, you can print on both sides, putting the paper through the
printer twice The first time through, the printer prints odd-numbered pages;
the second time through, it prints even-numbered pages.

Note: Use 28-pound or heavier paper for manual duplex printing. If you use a
lighter paper, the ink may bleed through the paper.

Put paper in the lower paper tray.
Remove any paper from the upper tray.
Choose Page Setup from the File menu.

Choose Book or Tablet from the Two-Sided Printing pop-up menu, and click OK.

Orientation: Scaling (%)
Two-Sided Printing:

S None ‘I they can be bound on the
[ Flip Horizontal left, as a book.
g;’:z::'s";:f';tl':mde Ink|_Tablet J Tablet prints the pages
so they can be bound at
the top, as a tablet.

Book prints the pages so

Color StyleWriter 4500 Page Setup | Choose the settings you
Paner e Faper Tupe: want, then click OK.
[ US Letter «] [ Plain Paper i !

Choose Print from the File menu.

The printer automatically prints the odd-numbered pages and delivers them
in the upper paper tray.

Following instructions on the screen to bring PrintMonitor to the front, choose
PrintMonitor from the Application menu.



6

Following instructions on your screen, put the stack of printed pages back into the lower
paper tray.

The odd-numbered pages of your document have
been printed and are in the 0UT tray. To print the
even-numbered pages of your document:

* Remove the printed pages from the OUT tray.

* Turn the stack of pages around 180 degrees,
keeping the printed side up.

* Insert the stack into the IN tray with the top
of the pages towards the printer.

Take the printed sheets out, rotate the stack and
insert it into the lower paper tray, with the printed
side up. The second side will be printed according
to what you choose (Book or Tablet) in step 3.

When the paper is ready, click OK.

When you're done with manual duplex printing (two-sided)

Take the time to reset the printer for normal printing. In the Page Setup dialog
box, choose None from the Two-Sded Printing pop-up menu.
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Printing a flipped document

You can flip a document, reversing text and pictures so they are correct when
you transfer the image to another surface (such as a T-shirt). Flipping can also
be useful when you print transparencies. (You can write on the transparency
without smearing the ink printed on the reverse sde)

1  Putpaperin the lower paper tray, print side down (as usual).
If youre using transparencies, put them in rough side down.
2  Choose Page Setup from the File menu.

3 Click Flip Horizontal and click OK.

Color Stylelriter 4500 Page Setup | Choose the settings you
Paper size: Paper Type: want, then click OK.
[ vusLetter +] [ Plain Paper -]
Orientation: Scaling (%):
Click X Two-5ided Printing
ick to put an : N :
i
in the box. _| L] Flip Horizontal
[Juse Color PhotoGrade Ink Cartridge
[ save as Default
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Choose Print from the File menu.
In the dialog box that appears, click Print.

The text and pictures print backwards. To see the reverse image, hold the page
up to amirror.

When you're done printing flipped documents

Take the time to reset the printer for normal printing. Here are some stepsto
remember:

= Inthe Page Setup dialog box, click Flip Horizontal to remove the X from
the checkbox.

s If you used transparencies or special paper, replace it with standard paper
in the lower paper tray.
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Defining your own custom paper sizes

Chapter 2

Occasionally, you may want to print on paper whose size does not appear in
the Paper Size menu on the Page Setup dialog box. If the size of the paper
falls within these ranges, you can useit:

Width: 5to 85 inches
Length: 583 to 14 inches

To print on the nonstandard paper, follow these steps:
|
Put the paper lengthwise into the lower paper tray.

For easier access, you can remove the upper paper tray, and then put it back
when the paper isin place

If the paper is shorter than

8.6 inches, squeeze the handle
so you can lower it before you
push the adjuster against the
stack of paper.




2

3

4
Specify the size

in inches or
centimeters.

If you are printing
nonstandard
envelopes, click to
put an X here.

5

Choose Page Setup from the File menu.

Choose Add Custom from the Paper Size pop-up menu.

In the dialog box that appears, type the appropriate information and click OK.

Please enter your custorm media size:

Fame:

|_@|nches Width: Height:[11. ]

Give the custom size
L aname.

) Centimeters

{1 Envelop

Type the width and height.

| When you're ready,
click OK.

Choose Print from the File menu.

Printing ‘
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Tips on Paper, Quality, Speed, and Cost

This chapter explains how to use different materials and printing options to
meet your needs.

Choosing print materials

Here are some tips on when and how to use different print materials.

Plain paper

Use plain paper for everyday printing.

Print quality may vary depending on the manufacturer of the paper.

If youre not happy with one kind of paper, try a different brand. For
consistent results, use one of the special papers designed for the

Color StyleWriter 4500 printer.

You can use any plain paper, including plain copier paper. Paper weight
can range from 16 to 36 pounds, though 20-pound paper is recommended.
Dont use erasable typing paper, damaged or wrinkled paper, stapled paper,
or multipart forms (“carbonless carbons’).

Plain paper almost always has one side that is better for printing than the
other. See the package label to determine which side is better, and load that
sde face down in the lower paper tray.
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Apple Color Ink-Jet Premium Coated Paper

This bright white coated paper is great for creating high-quality
presentations, newd etters, and reports

= Use only coated paper designed for use with the Color StyleWriter 4500.

= One side of the paper is alittle whiter than the other and is better for
printing. See the package label on the coated paper to determine which
sdeis better, and load that sde face down in the lower paper tray.

Apple Color Ink-Jet Glossy Paper

This glossy, heavyweight paper produces vibrant, permanent color images.
» Use only glossy paper designed for use with the Color StyleWriter 4500.

= When loading a stack of glossy paper into the paper tray, put a single sheet
of plain paper at the bottom of the stack to prevent misfeeding.

Apple Color Ink-Jet PhotoGrade Paper
Use this heavyweight, photo-quality paper together with the color Photograde
ink cartridge for printing photorealistic images.

= Use only PhotoGrade paper designed for use with the Color StyleWriter
4500.

= Load the PhotoGrade paper so that the shiny side is face down in the lower
paper tray.



Apple Color Ink-Jet Banner Paper

Use this paper to print a continuous document that contains pages strung
together—for example, a birthday greeting.

= Use only banner paper designed for use with the Color StyleWriter 4500.

= When loading a stack of banner paper into the paper tray, make sure the
torn edge at the top of the stack goes into the paper tray first.

Apple Color Ink-Jet Transparency Film
This fast-drying, smudge-proof transparency film is great overhead
presentations.

= Use only transparencies designed for use with the Color StyleWriter 4500.
These special transparencies may have a sheet of paper attached to them or
astrip of tape at one end; |eave the paper and the tape attached until after
printing.

» Load the transparencies so that the paper backing or the tape strip is face
up in the lower paper tray and the edge where the paper and film are
joined or the taped edge goes into the tray first.

Labels

Use labels for addressing envel opes and other purposes.
» Use only labels designed for use with ink jet printers.

» Load the labels face down in the lower paper tray. Put about 5 sheets of
plain paper under the stack of labels.

Index cards and postcards

Use index card or postcard stock when you want to print small messages, send
greetings, post information on bulletin boards.

» Load the cards so that the side you want to print on is face down in the
lower paper tray.

Tips on Paper, Quality, Speed, and Cost
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Chapter 3

Materials you can print on

Here are details about the kinds of materials you can use in your

Color StyleWriter 4500 printer.

Print material
Plain paper

Coated paper

Index cards

Glossy paper

Color PhotoGrade paper

Transparencies

Banner paper
(continuous computer
paper or Z-fold paper)

Envelopes

Labels

Special instructions

Use 16- to 36-pound paper.

= Use only paper designed for this printer.
= The whiter side should face down.

The print side should face down.

Use only paper designed for this printer.
The shinier side should face down.

= Use only paper designed for this printer.

The shiny side should face down.

= Use only transparencies designed for this printer.

The transparency may have a paper backing or a
paper tape on one edge. The paper or the tape
should face up going into the printer.

The edge where the paper and transparency are
joined or the taped edge of the transparency should
go into the paper tray first

= Use plain paper banner paper.

If there are perforated strips, tear them off.

= Atorn edge at the top of the stack should go

into the printer first.
Make sure the envelope flap is folded down flat.

To prevent misfeeds, put about 5 sheets of plain
paper under the stack of labels you insert.

= Put the labels in the tray face down.
= In the Print dialog box, choose Plain from the

Media pop-up menu.

For more information about paper sizes and specifications, see Appendix A

and Chapter 2.



Quiality

Select Best quality. —

Best quality takes
longer to print, but
you get better
quality—even on
plain paper.

For highest-quality printing of photographs or images, choose Best quality,
use the color PhotoGrade ink cartridge and print on PhotoGrade papers.

Color StylelWlriter 4500

P

ages:

e
3 From: To: Preview

Copies:

[ Print in Grayscale [ Print Back to Front

Also use the following selections in the Color Options dialog box. (To display
the dialog box, click the Color button in the Print dialog box.)

Color Stylelriter 4500 Options

Intensity:

Halftoning:

Color Matching: y #
l—lﬂuto - Cancel
Bleed Control: Help

For the best color
printing, choose
ColorSync from the Color
Matching pop-up menu.

For the best color, you need to choose a specific profile for your monitor. In
the ColorSync control panel, choose the D50 profile for your monitor. If there
isno D50 available for your monitor, choose Apple Multiple Scan 17 — D50.
The D50 profile gives you better “warm’ colors

For the best visual match between the colors on your monitor and printed
colors, select the Page-White Gamma option in the Monitors control panel.
(On some computers, the control panel is called Monitors & Sound.) To select
a gamma option, open the Monitors control panel, then hold down the Option
key while you click the Options button. In the Options window, click the Use
Special Gamma checkbox to put a check init. Then choose Page-White

Gamma from the menu.

On a multiscan monitor, make sure that the color temperature, or intengity, is
set to 9300 K (the default setting). See the monitor manual for instructions. If
you select the Page-White Gamma option with a color temperature other than
9300 K, your monitor colors could look too red or too blue compared to

printed colors.

For more information, see “Adjusting Color Options’ in Chapter 2.
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Speed

For faster printing, change the Print Quality setting in the Print dialog box.
(To display the dialog box, choose Print from the File menu.)

Color Stylelriter 4500

Quality:

Select Normal or |

Draft. Draft is faster
than Normal.

Cost

Chapter 3

Copies: _I

[JPrint in Grayscale

o From: To: Preview
(options ]
[J Print Back to Front

Color printing takes longer than black-only printing.

To reduce the amount of ink you use, select Draft quality in the Print dialog

box whenever possible

For smple graphics or for documents that are mostly text, use the color and
black ink cartridges. The color PhotoGrade cartridge should be used in place
of the black cartridge only when you need the best quality photorealistic

color printing.




Maintaining Your Printer

It doesn't take much effort to keep your Color StyleWriter 4500 printer in
good working condition. You smply have to replace the ink cartridges when
they run out of ink and clean the printer or print head if you notice a
problem. (For instructions on cleaning the printhead, see “ Cleaning the
cartridges’ in Chapter 5

For other service, see the information about service and support that comes
with your Color StyleWriter 4500.

IMPORTANT Follow all the safety instructions given at the beginning of
Chapter 1

Replacing ink cartridges

Look carefully at your printed documents to seeif a color is missing or faded.
Sometimes it's obvious—such as when you run out of black ink. At other
times you may notice that the colors seem wrong—such as when youre
printing a nature scene and you run out of yellow.

The best way to verify that ink is running low is to print the sample page
(For details, see " Printing the Sample Page’ in Chapter 1)

For instructions on replacing an ink cartridge, see “Installing the Ink
Cartridges’ in Chapter 1
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Cleaning the outside of the printer

Before you clean the printer, turn it off and unplug the power cord. Then
wipe the outside of the printer with a clean, soft cloth dampened with water.
If necessary, you can use a mild soap or detergent. Be careful not to get any
liquid in the power cord receptacle

WARNING Donit use ammonia-based or alcohol-based cleaners on or
around the printer—they may react with the plastic.

Chapter 4



Troubleshooting

This chapter provides solutions to some problems that you may encounter
while using your Color StyleWriter 4500 printer.

Aslong as you follow the maintenance instructions in Chapter 4, youre not
likely to have any problems with your printer. The most common source of
trouble is faulty software installation. To avoid these problems, follow the
software installation instructions in Chapter 1

WARNING |f you have a problem with your Color StyleWriter 4500
printer and nothing presented in this chapter solves it, consult the
service and support information that came with the printer for
instructions on how to contact an Apple-authorized service provider or
Apple for assistance If you attempt to repair the Color StyleWriter 4500
yourself, any damage you may cause to the printer will not be covered
by the limited warranty on your printer. Contact an Apple-authorized
dealer or service provider for additional information about this or any
other warranty question.
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Safety precautions
To prevent damage to the Color StyleWriter 4500 printer and harm to yoursel f
and other users, follow these safety tips

= Dot touch anything inside the printer except as described in the
instructions in this manual. Otherwise, you may damage delicate
mechanical parts

= Dornit shake ink cartridges. Ink can leak out and cause stains
= Dot touch the ink opening on an ink cartridge

= Dot oil theinsde of the printer.

= Dont attempt to disassemble the printer.

= Before you unplug the printer, make sure it is turned off. (The green power
light should be off) Turning the power off ensures that the carrier has
returned securely to its home position and the cartridges have been capped.

The Chooser doesn’t show the Color SW 4000 Series icon

If you open the Chooser and don't see the Color SW 4000 Seriesicon, you
probably need to install the appropriate printer software For instructions, see
“Installing Your Printer Software’ in Chapter 1

Also, make sure the QuickDraw GX software is turned off. You can remove it
from the Extensions folder or use the Extensions Manager to turn it off.

Installation is unsuccessful

If amessage tells you that installation was not successful, check to make sure
you turned off virus-detection software as explained in Chapter 1 If that
doesnit work, try removing corrupted fonts, as described in the next section.
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Removing items from your Fonts folder to solve installation problems

Itemsin your current Fonts folder can interfere with successful installation of
the printer software To correct the problem, follow these steps:

Quit all programs you are currently running.
Open the Fonts folder (inside the System Folder) on your computer.

Drag the following files out of the Fonts folder. (Look for files with exactly these names.)
= Avant Garde

= Bookman

= Delphian

= Garamond Narrow

= Helvetica Black and Helvetica Compressed
» Lubalin Graph

= LucidaBright

= Machine

= N Helvetica Narrow

= Nadianne

= New Century Schibk

= Old English Text

= Onyx

= Oxford

= Swing

» Zapf Chancery

» Zapf Dingbats

= Zed

You can put the fonts temporarily into anew folder and drag the folder to
your desktop. Then, after you install the Color StyleWriter 4500 software
(including these fonts), you can drag the temporary folder to the Trash.

Repeat the software installation procedure in Chapter 1.

For more details about fonts, see Appendix B.

Troubleshooting
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The computer crashes while attempting to print

When a computer suddenly stops working—either a message on the screen
tells you a system error has occurred, or the mouse and keyboard act as if
they're disconnected—the computer has crashed.

If your computer often crashes after you tell it to print a document, your
printing software may have become corrupted. Reinstall the printer software
by following the instructionsin “Installing Your Printer Software’ and
“Telling Your Computer to Use the Color StyleWriter 4500” in Chapter 1

The computer doesn’t recognize the Color StyleWriter 4500

Chapter 5

If you have selected the Color StyleWriter 4000 Series icon in the Chooser
but nothing prints, or you get a message that no Color StyleWriter 4500 is
connected, one of the conditions in the list that follows may be the cause

Note: Before you try to solve the problem, choose CSW 4000 Series
PrintMonitor from the Application menu to see if there are any error
messages and to check how many print requests are waiting. If you repeatedly
tried to print a document, there may be multiple copies waiting to print. You
can delete anything you dorit want by selecting itstitle, and then clicking the
Cancel Printing button. See “Monitoring and Controlling Background
Printing” in Chapter 2.

= A plug may beloose To make sure that all cables are securely connected,
turn off the computer and the printer, then unplug each end of each cable
you want to test and plug it back in. For connection instructions, see
Chapter 1

= You may have indicated the wrong port in the Chooser. Open the Chooser
and change the port selection. (Look at the back of the computer to see
whether you plugged the printer into the computer’s printer port [&] or
modem port [%])

= |f your computer is not connected to a network, turn off AppleTalk in
the Chooser.



» If you are trying to use a printer on a network, and the printer name isnt
listed in the Chooser, make sure that the printer is turned on and
connected to the network. Then try again to select the printer in the
Chooser.

» If the printer is connected to a Local Talk network, select the CSW 4000
Series (AT) in the Chooser, and make sure that AppleTalk is active (The
“AT” in the driver name stands for AppleTalk.)

» If the printer ison a Local Talk network, someone may have given it a new
name

= You may be using the wrong printer software Make sure you installed the
software as described in Chapter 1 and that you have selected the printer as
described in “Telling Your Computer to Use the Color StyleWriter 4500,
also in Chapter 1

= If youre using a PowerBook computer with an internal modem, change the
serial port setting to Normal or External. For details, see “ Specia
Information for PowerBook Owners’ in Chapter 1

= The printer may need to be reset. Turn the printer off, count to five then
turn it back on.

If you still carit resolve the problem, the printer may not be working properly.
See the information about service and support that came with your printer.

A PowerBook has trouble printing to the Color StyleWriter 4500

Some PowerBook computers have special requirements for printing. See
“Special Information for PowerBook Owners’ in Chapter 1

Troubleshooting
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The lights indicate a problem

Chapter 5

Sometimes the lights on the printer signal a problem.

Both lights are off.

= The printer is turned off. Press the power button. If you still dorit see the
glowing green light, make sure the printer is plugged into a power outlet
and that the outlet has power.

Both lights blink.

» Paper may be jammed in the printer. Open the front cover and remove any
jammed paper. To advance paper that is part way through the printer, press
the resume button. Close the front cover and turn the printer off, then on
again.

s Theink-cartridge carrier may be jammed. Close the front cover, turn the
printer off, then on again.

The power light blinks, and the resume light is off.

= Thisisnormal behavior when the printer is receiving data, printing, or
waiting for ink to dry.



The power light glows steadily, and the resume light blinks.

= One or both of the ink cartridges may not be seated properly, or you may
have forgotten to remove the tape from a new cartridge Open the front
cover. Remove both cartridges Holding the black plastic sides of the
cartridge, check to be sure the tape has been removed from the print head.
Then replace the cartridges in the carrier. Make sure each cartridge is
pressed all the way into the carrier. If acartridge feels at all loosg, it is not
properly seated. For instructions, see “Installing the Ink Cartridges’ in
Chapter 1

= Thefront cover may be open. Make sure it is closed.
= There may be no paper in the lower paper tray. Load paper.

= If you just printed a banner, you need to unload the remaining banner
paper. Tear off the unused paper in the tray. Then press and release the
resume button to advance the end of the banner through the printer.

= The printer may be confused. Press and rel ease the resume button.

The printer seems slow
See the suggestions under “Speed’ in Chapter 3

If you have a Macintosh I1fx, Macintosh Quadra 900, or Macintosh Quadra
950 computer, check the Serial Switch control panel. Make sure it is set to
Compatible

Paper is jammed

Occasionally a piece of paper may get stuck inside the printer during the
printing process. To clear a paper jam, follow these steps:

1  If necessary, open the front cover to see where the jam is.
2 Gently pull the paper free.
3 Toadvance any remaining paper, press and release the resume button.

4 Turn off the printer, then turn it on again.

Troubleshooting
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Paper or envelopes feed improperly
If paper tears, gets skewed, or comes through the printer crumpled, it may not
be entering the printer properly. Try the following:

m Make sure you have loaded the paper correctly, paying special attention to both
paper adjusters.

For instructions on loading paper, see “Loading Paper into the Paper Tray
in Chapter 1

= Do not overload the paper tray.

If you use heavier paper, fewer sheets will fit in the paper tray.
m Do not force paper into the paper tray.
= Try to remove any torn or damaged pieces of paper from the printer.
See “Paper |Is Jammed,” earlier in this chapter.
Take the paper out of the paper tray and check it.

Make sure none of the sheetsis curled, bent, or dog-eared.
Make sure the edges of the stack line up evenly.

Make sure the paper adjusters arer’t too snug or too loose The stack
should lieflat (not bowed).

Load either envelopes or paper (not both) into the paper tray.

Make sure you have inserted envelopes correctly. The flaps should lie flat
against the envelope, the edges should be smoothed flat, and no air should
be trapped in the envelopes

When loading transparencies, the side with the tape or the paper backing
should face up. The taped edge or the edge where the paper and the
transparency are joined should go into the paper tray first.
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The Color StyleWriter 4500 won't print a particular document

If you attempt to print a document and no page is printed—not even a blank
one—try the following:

Check for messages on your computer screen. Also, choose CSW 4000
Series PrintMonitor from the Application menu.

Your computer may be low on memory. See “Memory IsLow;" later in this
chapter.

Turn the printer off, then on again. (This resets the printer)
Repeat the printing process

Sometimes problems disappear when you try to print your document again.

Printing problems can often be caused by errorsin your applications. If
you can print from the SmpleText or TeachText application but not from
another application, it's probably a problem with that application. Contact
the publisher of that application for help.

Restart your computer.

The printer acts as if it's working, but nothing is printed on the page

If your printer takes the paper, but doesnt actually print anything, try the
following:

If the ink cartridge is hew, make sure that you removed the tape from its
print head.

Make sure the ink cartridges are correctly installed. (For instructions, see
“Installing the Ink Cartridges’ in Chapter 1)

The printer may be out of ink, or the cartridges need to be ceaned. You
can check by seeing whether the sample page prints. See “Printing a
Sample Page’ in Chapter 1 For instructions on cleaning the cartridges, see
“Cleaning the Cartridges” later in this chapter.

Troubleshooting
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Messages appear on your computer screen

Memory is low

Chapter 5

M ost messages that appear on your screen are self-explanatory. For example,
they may tell you that the printer is out of paper or that the paper is jammed.
Once you correct the problem, the message goes away.

These messages usually mean what they say. Occasionally they appear when
you have the wrong port indicated in the Chooser. See “Telling Your
Computer to Use the Color StyleWriter 4500” and “ Special I nformation for
PowerBook Owners’ in Chapter 1

Oncein awhile, your computer may be temporarily low on random-access
memory (RAM).

Symptoms that indicate a memory problem:

= Some documents do not print.

= Some text incorrectly appears in the Geneva font.

» Characters look jagged.

= An “out of memory” message appears on your screen.

If you have a memory problem, try the following:
= Run only one program at atime; quit the ones youre not using.

= |f memory has been severely fragmented, you should quit all open
applications, then reopen just the one youre using.

= Increase the amount of memory you give to the program youre printing
from by using the Get Info command (as explained in the instructions that
came with your computer)

= Turn off background printing. See “Printing While You Use Your
Computer” in Chapter 2.

= In the Page Setup dialog box, choose Portrait (normal) orientation instead
of Landscape (sideways) orientation.

» Print color documents using “Print in Grayscal€’ in the Print dialog box.
Printing in grayscal e takes the least memory.



= Turnon virtual memory in the Memory control panel. Virtual memory is
described in the instructions that came with your computer. (Note: Using
virtual memory can dow down your computer.)

= Obtaining additional RAM for your computer can solve some of these
problems and improve printing speed.

» Restart your computer. Some software applications retain memory
resources even after you have quit the application. The only way to recover
this memory is to restart.

Documents did not print as expected

If the quality of printing is OK—not smeared or incomplete—but the result is
not as you expected, you may have made a mistake in using the printer
software. For example, in the Page Setup dialog box, someone might have
checked “Save as Default.” If it is checked, and you are not getting the results
you expect when you print, click the checkbox to remove the X. Make sure
the settings in Page Setup are what you want, and then try printing again.

For additional help, read the subsections that follow for suggestions

Text appears in the Geneva font or prints jagged

When your computer is low on memory, it may display and print certain fonts
in the Geneva font iiGenewa looks like thiz.] Some text may also have jagged
edges. To fix low-memory problems, see the preceding section, “Memory

Is Low”

For more information about fonts, see Appendix B, “Using Fonts With the
Color StyleWriter 4500

Some rotated text may print jagged if you apply a style that has not been
defined for the font. Try applying plain style to the text.
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Graphic images appear jagged

Some advanced page layout and art applications use the PostScript page
description language, alanguage that the Color StyleWriter 4500 does not
understand. If your applications have a PICT preview option, you can print
the file on a Color StyleWriter 4500. I mages saved as encapsulated PostScript
(EPS) may appear jagged on all non-PostScript printers. For normal color
images, substitute a TIFF or PICT version of the image

Page breaks change unexpectedly

Most applications determine where to break pages by evaluating the
information you provide in the Page Setup dialog box. Also, different types of
printers space text in dightly different ways. The following actions can cause
page breaks to change:

= changing from one type of printer to another

= changing the paper size in the Page Setup dialog box
= scaling the document in the Page Setup dialog box

= changing the orientation in the Page Setup dialog box

It's best to choose the printer you want and the Page Setup options you need
before working on your page breaks.

A page prints off center

This problem may result from one of the following conditions:
= You have sdlected the wrong paper size in the Page Setup dialog box.
= The margins are set incorrectly in the document you are printing.

= Paper is not placed properly in the paper tray. See “Paper or Envelopes
Feed Improperly,” earlier in this chapter.



Text lines up in columns on the screen but not when it prints

You may have used spaces (rather than tabs) to line up the text. Because
printers interpret spaces differently than the screen does, the text may fail to
line up when you print it. Try replacing the spaces with tabs

You can also make columns by using spaces with a monospace font—such as
Courier or Monaco—instead of tabs. A monospace font is one in which every
character has the same width.

Everything prints backwards

Choose Page Setup from the File and see whether therés an X in the “Flip
Horizontal” checkbox. If so, click to make the X disappear.

Print quality is poor
Most image problems are caused by problems with an ink cartridge or with
your choice of paper. Dont use the following types of paper:
» erasable typing paper
» damaged, wrinkled, or stapled paper
= multipart forms (“carbonless carbons’)
» glossy paper, unlessits especially designed for StyleWriter printers
For best print quality, use coated, glossy, or PhotoGrade paper. If you use
plain paper, use 16- to 36-pound copier paper; 20-pound paper is

recommended. Plain papers can vary widely. If youre not happy with one
kind of paper, try a different brand.
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The image is too light or too dark

If printing looks fuzzy because it's too light or too dark, try the following:

Clean the cartridges. See “Cleaning the Cartridges,” later in this Chapter. If
this doesrit help, replace one or both ink cartridges. See “Installing the Ink
Cartridges’ in Chapter 1 for instructions.

Make sure youve chosen the correct paper type in the Print dialog box.

If youre using plain paper, try flipping the stack of paper in the paper tray.
Most paper has one side that's better for printing. If youre using other
material, make sure you have it loaded in the correct orientation. See
“Loading Paper into the Paper Tray” in Chapter 1

Try printing on a different kind of paper.
Try choosing Best print quality in the Print dialog box.

Try adjusting the Intensity control. Choose Page Setup or Print from the
File menu, and then click Options. In the dialog box that appears, choose a
different setting in the Intensity pop-up menu.

Thin lines fade or break up

Pick a darker color for the affected object, or try printing with the Pattern
halftoning option selected. (In the Print dialog box, click the Options button,
then choose Pattern from the Halftoning pop-up menu.)

The ink smears when rubbed

Dont handle pages before the printer drops them into the output tray. Wait
several minutes before handling doucments printed on glossy or PhotoGrade
paper or on transparency film.

Printing appears on only part of the paper
Check the selections in the Page Setup dialog box.

Clean the cartridges. See “Cleaning the Cartridges,” later in this Chapter. If
this doesrit help, replace one or both ink cartridges. See “Installing the Ink
Cartridges’ in Chapter 1 for instructions.



Colors don't ook right on the printed page

Try the following:

= Print asample page to seeif youve run out of ink. For instructions, see
“Printing a Sample Page’ in Chapter 1

= Clean the cartridges See “Cleaning the Cartridges” later in this Chapter. If
this doesrit help, replace one or both ink cartridges. See “Installing the Ink
Cartridges’ in Chapter 1 for instructions.

= Try printing the image with ColorSync turned on. See “Quality” in
Chapter 3

» Use adifferent type of paper.

= Make sure youve selected the paper youre printing on from the Paper
Type pop-up menu in the Page Setup dialog box.

Unwanted horizontal white lines or stripes appear

Problems with print quality, especially horizontal white linesin your
document, may mean a nozzle on the print head is clogged or your ink
cartridge is running out of ink.

Clean the cartridges. See “ Cleaning the Cartridges” later in this Chapter. I
this doesrit help, replace one or both ink cartridges. See “Installing the Ink
Cartridges’ in Chapter 1 for instructions

IMPORTANT Cleaning the cartridges consumes a small amount of ink. If you
repeat the procedure unnecessarily, you reduce the life of your cartridges.

Troubleshooting
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Click Start

Cleaning the cartridges

To clean the print head, load plain paper in the paper tray and make sure the
printer is turned on. Then follow these steps:

Cick Utilities in the Page Setup dialog box.

Color Stylelldriter 4500 Page Setup
Media Size: Media:
[ USLetter ~| [ Plain Paper -]
| Click Utilities.
Orientation: Reduce/Enlarge: 3’%

I Two-5ided Printing:

[ Flip Horizontal
[J use Apple Photo Cartrid [ save as Default

In the Utilities dialog box, find Clean Print Cartridges and click Start.

Color Stylellriter 4500 Utilities

Clean Print Cartridge: cancel

Align Print Cartridges:

The printer cleans the print head, printing a page in the process.

The image prints wavy or distorted

Make sure that you are using a recommended type of paper. If the problem
persists, see the information about service and support that comes with
the printer.

Stains appear on printed pages

Stains on the backs or tops of printed pages may mean that ink has spilled
insde the printer. If so, the ink can transfer to the rollers and from there to
the paper.

Turn the printer off and unplug it. Then open the printer and carefully clean
the rollers and platen with a soft, dry cloth.



Ink cartridges run out of ink too quickly

To extend the life of your ink cartridges, try the following:

= Select Draft print quality in the Print dialog box whenever you can.
= Dornit clean the print head unless necessary.

= Dot print solid background colors unless necessary.

= Dot print the sample page unless necessary.
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Appendix A
Technical Information

General specifications

Marking engine

Four-color thermal ink—jet engine; six-color with the color PhotoGrade ink
cartridge

Resolution

The resolution differs according to the quality of printing you select. It is
expressed in horizontal by vertical dots per inch (dpi).

Best Black: 600 x 600 dpi

Best Color: 600 x 300 dpi on coated or glossy paper or on transparencies
(300 x 300 dpi on plain paper)

Normal Black: 600 x 300 dpi

Normal Color: 600 x 300 dpi on glossy paper or transparencies
(300 x 300 dpi on plain or coated paper)

Draft Black: 300 x 300 dpi
Draft Color: 150 x 300 dpi

Engine speed

Printing speed depends on the images printed and on the Mac OS-based

computer used.
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Connector cable

Apple System/Peripheral-8 cable

Interface

Local Talk
High-speed serial (RS-422-A)

Fonts

TrueType font support
64 TrueType fonts including the fonts provided on your computer

Adobe PostScript font support when used with Adobe Type Manager
software (sold separately by Adobe Systems I ncorporated)

Lower paper tray

Holds up to 100 sheets of 20-pound (75 grams/meter? ) paper,
20 envelopes, 20 sheets of banner paper, up to 30 cards, up to 50
transparencies, up to 25 sheets of paper labels.

Output tray

Holds up to 50 sheets of 20-pound (75 grams/meter? ) paper.

Printing materials

Plain paper: Use 16-pound (60-g/m?) to 36-pound (135-g/m3).

Envelopes: Use C6, DL, A2, or #10 envelopes, 20 to 24 |b. (75 to 90 g/m?).
Continuous banner paper: Use 20 Ib. (75 g/m?).

Labels: Accepts paper labels designed for ink-jet printers.

Cards. Use 110 Ib. index maximum, 8.5 pt. maximum (110 to 200 g/m?).

Apple recommends transparency film, premium coated paper, glossy
paper, and color PhotoGrade paper especially designed for the Color
StyleWriter 4500 printer. See your Apple-authorized dealer for more
details



Paper sizes in inches (") and millimeters (mm)

U.S Letter: 85" x 11" (2159 mm x 2794 mm)
Banner U.S Letter: 85" x 11" (2159 mm x 2794 mm)
US Legal: 85" x 14" (2159 mm x 3556 mm)
Executive: 7.25" x 105" (18415 mm x 266.7 mm)
A4: 83" x 117" (210 mm x 297 mm)

Banner A4: 83" x 11.7" (210 mm x 297 mm)

A5: 58" x 83" (1485 mm x 210 mm)

B5JIS: 72" x 101" (182 mm x 257 mm)

#10 envelopes: 95" x 4125" (241.3 mm x 104.8 mm)
C6 envelopes: 448" x 6.37" (114 mm x 162 mm)
DL envelopes: 4.33" x 866" (220 mm x 110 mm)
A2 envelopes: 4.375" x 575" (111 mm x 146 mm)
US Card 4x6: 4" x 6" (10061 mm x 1524 mm)

US Card 5x8: 5" x 8" (127 mm x 2032 mm)

A6 card: 41" x 583" (105 mm x 1485 mm)

Hagaki card: 39" x 58" (100 mm x 148 mm)

Printable area in inches (") and millimeters (mm)

Maximum printable line in portrait (normal) orientation: 8" (2032 mm)

Minimum margins

Left and right: 0.25" (604 mm)
Top: 0.26" (6.6 mm)

Bottom: 059" (150 mm)

Dimensions in inches (") and millimeters (mm)

Height: 79" (199 mm)
Width: 172" (436 mm)
Depth: 16" (405 mm)

Weight

Approximately 1.6 pounds (5.3 kilograms)

Technical Information
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Operating environment
Temperature

= 5°1040° C (41° to 104° F)
Relative humidity

= 10 percent to 80 percent, noncondensing

Storage environment

Temperature

= —40°t0 60° C (—40° to 140° F)

Humidity

= 5 percent to 90 percent, noncondensing

Power Consumption

Operating

= 2 watts maximum when off

= 4.5 watts maximum nonprinting
s 12 watts maximum when printing

Power requirements for AC power adapter

The electrical requirements vary depending on the country for which your
model was manufactured.

Power supply

= AC power adapter
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Apple printer supplies and accessories

If you have trouble finding any of the following products, the part numbers
may help you describe them to the dealer. Note, however, that part numbers
sometimes change as products are enhanced.

Ink cartridges

= Color ink cartridge: M5694G/A

= Black ink cartridge: M5693G/A

= Color PhotoGrade ink cartridge: M5692G/A

Connector cable
» Apple System/Peripheral-8 cable: M0197LL

Printing materials

Apple offers a complete line of high-quality, specialty ink-jet papers for
use in your printer. These papers are specially designed to make your
output look sharper, brighter, and more vibrant. Look for them at an
Apple-authorized dealer.

= Apple Color Ink-Jet Transparency Film

= Apple Color Ink-Jet Premium Coated Paper
a Apple Color Ink-Jet Glossy Paper

» Apple Color Ink-Jet Color PhotoGrade Paper
= Apple Color Ink-Jet Banner Paper

» Apple Color Ink-Jet Greeting Card Kit

Available Options
» LocalTalk RJ11 Connector Kit DIN-8: M1657Z/A
» LocalTalk Locking Connector Kit DIN-8: M2068LL/B

Where can you obtain these supplies and accessories?

See any Apple-authorized dealer. In the U.S, call 1-800-538-9696 for the
location of the dealer nearest to you.

Technical Information
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Kinds of fonts

Appendix B
Using Fonts With the Color StyleWriter 4500

A font is acollection of letters, numbers, and symbols in a distinctive
typographic design. Your Mac OS-based computer and Color StyleWriter
4500 printer come with a variety of fonts that look great both on your
monitor and on paper.

Fonts come in such avariety of formats that problems can sometimes arise
This appendix provides the information you need to avoid such problems and
to solve them if they come up.

The Mac OS-based computer works with three main kinds of fonts:
TrueType, bitmapped, and PostScript fonts.

Two kinds of fonts come with your computer and the Color StyleWriter 4500
printer: TrueType and bitmapped. However, your system can use PostScript
fonts as well when it has the proper software installed.
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TrueType fonts

A TrueType font is scalable, describing a typeface without rigidly specifying a
size So it looks good whatever size you choose TrueType fonts provide sharp
text at any size on screen or on paper. You can mix and match TrueType fonts
from various font vendors

g

Courier

TrueType fonts store individual text characters as mathematical descriptions
of lines and curves, rather than as groups of pixels (a bitmap). When a
program asks for a character in a particular size, such as 33 points, the
computer uses mathematical calculations to enlarge the character's outline
to 33 points and fill in the dots for the monitor or printer output.

Sometimes you Il still get jagged edges when you print a document, even
when you use a TrueType font. In nearly all cases, thisis because there isnt
enough memory available to scale the font properly for printing. This may
happen, for example, when youre running several programs at the same time

Because you dorit need a separate font for each character size in order for
your printing to look good (as you do with bitmapped fonts), TrueType font
names dont have numbers in them.



How does a font look? To see what a TrueType or bitmapped font looks like
on your screen, double-click the font'sicon to open it. A sample of that font
appears (in three sizes for TrueType fonts and in the size you opened for
bitmapped fonts).

=

Palatino = —— EM

Palatino 12

-3 paint -+ Sample
How razorbackjumping frogs ean level six piqued Heomwr razorback-jurnping frogs can
& ) lewel six piqued gyrmnasts!

- 12 point
Howr razorback-jurmnping frogs can level
six piqued gyrrrasts!

- 18 point

Howr razorback-jumping
frogs can level six piqued
gymnasts!

To use this font, drag it onto your System Folder

To use this font, drag it onto your System Folder

You can also use the Key Caps desk accessory to examine fonts. See the
documentation that came with your computer for instructions.

Bitmapped fonts

Bitmapped fonts congist of “pictures’ of atypeface at specific Szes For
example, you might have bitmapped fonts at 10-, 12-, and 18-point sizes
installed in your computer. For best results you need a separate font file for
each size of character you want to use

Theicon of abitmapped font (also called a fixed-size font or screen font) has
the single letter A on it. The font's point size appears at the end of its name.

A

Monaco 12

When you request a bitmapped character, your looks for an installed
bitmapped font in the size you specified. (See “How the Computer Looks for
Fonts’ later in this appendix) If it cant find that font, your computer tries to
construct one by scaling asize that it does find.

Using Fonts With the Color StyleWriter 4500 ‘ 95
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In most cases, scaled bitmapped fonts dort look nearly as good as
preinstalled ones Such scaling is one reason for the jagged edges (sometimes
called “jaggies’) you Il see on your screen or in a printed document when you
request an uninstalled size (for example, 17-point Geneva).

Bitmapped fonts are designed on grids of 72 dots per inch (dpi)—the
standard Mac OS-based computer screen resolution. Because of their
correspondence to the standard screen resolution, bitmapped fontsin
preinstalled sizes always look great on your display.

When you print a bitmapped font, it prints at a resolution of 72 dpi. Because
most modern printers can print at resolutions far better than this (your
Color StyleWriter 4500 prints at 300 dpi or better), printed bitmapped fonts
almost always have jagged edges or stairstep sides

Fortunately, the computer can use bitmapped fonts in combination with other
font formats, reserving bitmaps for the screen and other kinds of fonts for
the printer.

PostScript fonts

PostScript is a page-description language that defines the characters, symbols,
and images that appear on each page of a document. A PostScript font comes
as apair of fonts: an outline font for the printer and a corresponding
bitmapped font for displaying type on your screen.

No bitmapped font, no menu entry: If your system doesrit have the bitmapped
font, the PostScript font name won't appear in your font menu.

Couri

Certain printers are designed specifically to work with PostScript fonts
While your Color StyleWriter 4500 is not a PostScript printer, it can use
PostScript fonts if you have Adobe Type Manager software installed. Adobe
Type Manager uses printer fonts to generate clean-looking screen text at any
size (This software is included with some installations of system software 7.5
It is available from your local Apple-authorized dealer for version 71)



IMPORTANT Adobe Type Manager is not an Apple product. It is made and
supported by Adobe Systems Incorporated. Only the version that comes with
Apple Macintosh system software version 75 is supported by Apple

PostScript printer fonts have no numbers associated with their names,
because a single font can be scaled to any size Many companies make
PostScript fonts; the following illustration shows icons for Adobe, Bitstream,
and Fontek PostScript fonts, plus a generic PostScript font icon.

Zl & [El &

Using Fonts With the Color StyleWriter 4500
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How TrueType fonts work with other kinds of fonts

Appendix B

Although TrueType fonts offer distinct advantages, your Color StyleWriter
4500 printer can also use other kinds of fonts.

TrueType and bitmapped fonts

Mac OS—-based computers running System 7 come with both bitmapped
(screen) fonts and TrueType fonts installed. This maintains consistency with
documents created on Mac OS—-based systems that don't have TrueType fonts.

EDE Courier EEE
123 items 142.2 ME in disk 9.7 ME available

Courier

Courier 3 Cogrjer 10 Courier 12 Courder 14 Courier 18

=] [

Bitmapped fonts look better displayed on the monitor, while TrueType fonts
look better on a high-resolution printer such as the Color StyleWriter 4500.
So, if you have both versions of the font available, your computer uses the
bitmapped version when displaying the font on the screen (provided that the
Sizeyoure using is available) and the TrueType version when printing the font
on the Color StyleWriter 4500. To force the Macintosh to use only TrueType
fonts everywhere, you must remove the bitmapped fonts

For example, if adocument uses 12-point Times®, available in that sizeasa
bitmapped font and as a TrueType font, the system uses the bitmapped font on
the screen and the TrueType font on the printer. If a document uses 4-point
Times, the system scales the TrueType font to that size for both the screen and
the printer, because a bitmapped version isn't available



Using only TrueType fonts produces a closer match between the appearance
of type on the screen and on paper. However, a document youve already
created with bitmapped fonts will be reformatted with the corresponding
TrueType fonts, and line breaks in the document may change Smilarly, if a
document is created on a system that has TrueType fonts or Adobe Type
Manager software installed, it may have different spacing, kerning, and so on,
when opened on a system that doesrit have TrueType fonts or Adobe Type
Manager software

Keeping two font versions available

If you have a TrueType version of afont, you dort need a bitmapped version.
However, although keeping both versions of a font takes up more disk space,
there are several advantages to doing so.

Bitmapped fonts are hand-designed: a graphic artist planned each character
in each font to look good on a screen. TrueType fonts are scaled by the
computer to match what you request. At smaller point sizes, the bitmaps may
appear sharper on the screen.

Additionally, scaling fonts takes time—sometimes up to several secondsin
dower Macintosh computers—but all Macintosh computers can display a
bitmapped font instantly.

TrueType and PostScript fonts

PostScript fonts were designed as fonts for PostScript printers The Color
StyleWriter 4500 wasit designed to use PostScript. However, if you have
Adobe Type Manager software installed, your computer can both display and
print PostScript fonts

Use different names:. To avoid confusing the printer software, be sure that you
dorit install both TrueType and PostScript versions of the same font. For
example, do not have a PostScript font file called Times and a TrueType font
file called Timesinstalled in your system at the same time.

Using Fonts With the Color StyleWriter 4500
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Herés the search order your computer uses to determine which font to display
on your screen when you choose a specific size:

1 aninstalled bitmapped font in that size, if one exists
2. ascaled TrueType font, if no bitmapped font exists

3 an Adobe Type Manager (ATM) version of a PostScript font, if ATM is
installed and if no TrueType version exists

4. ascaled bitmap if no ATM font exists

Herés the search order it uses to determine which font to print on your
Color StyleWriter 4500 printer:

1 ascaled TrueType font, if one exists

2. an ATM version of a PostScript font, if ATM isinstalled and if no
TrueType verson exists

3 ascaled 72-dpi bitmap if no ATM font exists



Where fonts are stored

All fonts for your Color StyleWriter 4500 printer reside in special places
within the System Folder. To install fonts, you drag them to the System
Folder. Your Macintosh will automatically put them where they belong—in
the Fonts folder within the System Folder.

The Fonts folder can contain atotal of 128 font suitcases (described in the
next section), plus any number of PostScript fonts, up to the available storage

capacity of your hard disk.
S==——————— fmnis =————1%
Marme Size Kind 1
=T =
HelveMarObl ZEk PostSoeript™ font
Helvetica 4K font suitcase
HyperCharacters briap 12K font suitcase
London 4K font suitcase
Loz Angeles 12K font suitcaze
MerrionSquare brap 8K font suitcase
é MerriSqu 24K PostSoeript™ font
Mobile 12K font zuitcase
Menace JEK font suitcaze
3] MT Extra 20K font suitcasze
MTExt 12K PostSeript™ font
New ‘ork 28K font suitcase
Falating 296k font suitcaze
San Francizco 4K font suitcase
Symbol T2K  font suitcase
Tirmes ZEdk font suitcaze
TimesBol ZEk PostSoeript™ font

IMPORTANT Fontsinstalled in other folders or in the top level of the System
Folder may not work correctly. Additionally, bitmapped and TrueType fonts
stored outside of suitcases may not work correctly.
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Suitcases

A font suitcase is a special folder for collections of fonts.

4]

Courier

Suitcases provide a convenient way to organize fonts in the same font family.
For example, its agood ideato use a single suitcase (called Courier) for all
fonts in the Courier font family—all Courier roman fonts as well as fonts
with names like Courier Bold and Courier Oblique.

| Courier Oblique 10 T font
IC

S 1I=——" = Courier =i———=—1%
23 items 1421 MB in disk 89.8 MB availablg
| Marme. Size  Kind

|d El Courier BoldOblique 12 12K font
E El Courier BoldOblique 24 15K font
@ Courier 59K font
E Courier 9 Sk font
B courier (botd) 56K font
[ courier 10 5K font
(Al courier1z 6K font
[ courier 14 6K font
(A courier 12 7K font
(A courier 24 10K font
(A

A

ier Oblique 12 T font

= I

Combining suitcases. To merge all the fonts from one suitcase with another,
drag one suitcase on top of the other. All the fonts from the dragged suitcase
will go into the other, and the dragged suitcase will disappear.

Note: To avoid confusion, rename a font suitcase whenever you put more
fontsinto it. For example, if you decide to merge Helvetica, Helvetica Black,
and Helvetica Compressed, name the suitcase something like “Helvetica
Regular/Black/Condensed.”

A suitcase can also contain fonts from different font families, although you
should keep all fonts of the same family in the same suitcase All the fonts
will still appear in menus with their proper names.



Styled fonts

You treat a suitcase as you would a folder. To open a suitcase, you double-
dick it. To add afont, you drag the font's icon to the suitcase and drop it in.
To remove afont, you drag itsicon out of the suitcase

To create a font suitcase, duplicate an existing one and throw away its
contents. Then rename the suitcase as appropriate and drag whatever fonts
you want into it.

You cannot have more than 128 font suitcases in the Fonts folder.

Sze limits for suitcases: No matter how many fonts you have in asingle
suitcase, the Fonts folder counts the suitcase as a single unit. Therés no limit
to the number of fontsin a single suitcase, but the suitcase cannot be larger
than 16 megabytes.

Most fonts that come with your Color StyleWriter 4500 printer have defined
styles. For example, if you open the Bookman font (contained in a suitcase in
the Fonts folder, which isinside your System Folder), you see files for bold
and italic versions of the font.

E[1=———= Bookman =——=-1§
(14 items 58.4 ME in dizk 16.6 MB available
N
Bookrnan Eookrnan (baold)
Bookman (italic) Eookman (bold, italic)
i
@] [o&
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But fonts such as Chicago, Geneva, Monaco, and New York do not come with
defined styles. If you open the Chicago font suitcase, you see only one file

= Chicago EH
91 itern  52.4 ME in disk 166
i
Chicago
=
] B3

You can apply a style to a font like this by making a choice from the
appropriate menu (Fonts, Style, Format, or some similar menu, depending on
the application program). A font predesigned with a given style nearly always
looks better than a font with a computer-generated “derived’ style

About style names. Predesigned styled fonts sometimes have names you may
not be familiar with. For example, roman refers to a font without styling, or
plain. Obliqueis similar to italic. Light, demi, and extra are different kinds

of bold.

Common questions about fonts

Appendix B

Here are some questions that often come up about fonts.
What kind of fonts should I buy?

Using a font that has both bitmapped and TrueType versions works best. The
bitmapped version looks great on the screen and the TrueType fonts print
beautifully on the Color StyleWriter 4500.

Avoid bitmapped fonts that don't have TrueType versions because they print
with jagged edges on the Color StyleWriter 4500. By contrast, TrueType fonts
work well, even if you don't have a bitmapped version.

If you have a PostScript printer or Adobe Type Manager, PostScript fonts
look great on paper. The Color StyleWriter 4500 is not a PostScript printer.



Why don't all of my fonts appear in the Fonts menu?

You may not have all of your fonts placed correctly. All the fonts should be
installed in the Fonts folder in the System Folder.

Additionally, some application programs let the user decide which fonts
should appear in the Fonts menu. Check the manuals that came with your
programs.

Why can’t | see my Monaco 9, Geneva 9 and 12, and Chicago 12 bitmapped fonts?

These fonts are used by your Mac OS-based computer to display information.

Because the computer needs these fonts, the Finder makes them invisible to
prevent users from removing them.

What does the term Apple classic fonts mean?

The Apple classic fonts are the original ten bitmapped fonts that came with
the first Macintosh in 1984. These fonts, which all have city names, include
Athens, Cairo (a picture font), Chicago, Geneva, London, Los Angeles,
Monaco, New York, San Francisco, and Venice Several of the fonts (Athens,
Cairo, London, and San Francisco) came in only one size—18 points

This is a sample of Athens.
Qﬁw\r ﬁm g mﬁ?@m"@ {Cairo}

This is @ sample of Chicago.
Thisis a sample of Geneva.

This is a sample of Tondoun.
Thiz [z @ sample of Loz Angeles.

This is o sample of Monaco.

This is a sampls of New Tork.

Thil i§ a $ample of Ban Franeciico.

This is a sample of Venice.
Chicago, Geneva, Monaco, and New York are currently available in TrueType
versions. The other classic fonts are still only available in bitmapped versions.

Why do | sometimes get Geneva or Courier in my printed documents when | have
specified other fonts?

Geneva sometimes appears when youre trying to use a TrueType font but
dorit have enough memory for scaling to operate properly.

Substitute fonts can also appear in a document composed on one Macintosh
that has a particular set of fonts but printed on another Macintosh that doesrit
have those fonts.

Using Fonts With the Color StyleWriter 4500
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Why does a document written entirely in Times look different on different Macintosh
computers?

Times, an extremely popular font, is manufactured and sold by more than one
company. Such fonts usually have small differences, even though they have the
same name. For example, the Times font manufactured by Adobe Systems
Incorporated has different letterspacing than does the Times font from Apple
Computer, Inc.

What is font substitution?

Font Substitution, which isrit available for your Color StyleWriter 4500
printer, is an option in the Page Setup dialog box for certain PostScript
printers When font substitution is turned on, these printers will use their
built-in equivalents for three bitmapped fonts (Times for New York, Helvetica
for Geneva, and Courier for Monaco).

What's a downloadable font?

A downloadable font is a TrueType or PostScript font sent to some kinds of
printers, such as most PostScript Laser printers, by your system software The
printer then uses the font to print your document.

If aprinter has sufficient memory, it can hold more than one downloaded
font; otherwise it must request the fonts it needs as necessary. This can be a
time-consuming process.

Some printers have hard disks attached to them for holding downloaded fonts
A printer can get the fonts from its hard disk more quickly than it can
download them from the computer's hard disk.

Your Color StyleWriter 4500 printer cannot receive downloaded fonts
Instead, your computer composes the entire image and then sends it to your
Color StyleWriter 4500 for printing.



Appendix C
Font List

Between the fonts that come with your Mac OS—based computer and those
that come with the printer, there are 28 font families (and 64 total styled
fonts) available as soon as you install the Color StyleWriter 4500 software.

Name in Font menu

Avant Garde

Bookman

Chicago

Courier

DELPHIAN

Garamond Narrow

Geneva

Helvetica

Helvetica Black

Helvetica Compressed

Number of fonts

4

Font family (and styled fonts)

ITC Avant Garde®
(plain, italic, bold, and bold-italic)

ITC Bookman®
(plain, italic, bold, and bold-italic)

Chicago

Courier
(plain, italic, bold, and bold-italic)

Delphian

ITC Garamond® Narrow
(plain, italic, bold, and bold-italic)

Geneva

Helvetica®
(plain, italic, bold, and bold-italic)

Helvetica Black
(plain and italic)

Helvetica Compressed
(plain and italic)

Comes with

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Macintosh

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Macintosh

Color
StyleWriter 4500

Color
StyleWriter 4500

continued »
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Name in Font menu

Lubalin Graph
Lucida Bright
MACHINE

Monaco

N Helvetica Narrow
Nadianne
New Century
Schoolbook

New York
Oy €nglish Text

Onyx

Oxpord

Palatino

Swing

ZyuBol (Symbol)
Times

Zapf Chancery
K&k kRO EVA
(Zapf Dingbats)

Z3% 4 % (Zeal)

Total

Number of fonts

4

64

Font family (and styled fonts)

ITC Lubalin Graph®
(plain, italic, bold, and bold-italic)

Lucida Bright
(plain, italic, bold, and bold-italic)

ITC Machine®

Monaco

Helvetica Narrow
(plain, italic, bold, and bold-italic)

Nadianne
(plain and bold)

New Century Schoolbook
(plain, italic, bold, and bold-italic)

New York
Old English Text

Onyx

Oxford

Palatino®

(plain, italic, bold, and bold-italic)
Swing

Symbol

Times®
(plain, italic, bold, and bold-italic)

ITC Zapf Chancery®
StyleWriter 4500

ITC Zapf Dingbats®

Zeal

Comes with

Color
StyleWriter 4500

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Color
StyleWriter 4500

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Color
StyleWriter 4500

Color
StyleWriter 4500

Color
StyleWriter 4500

Macintosh

Color
StyleWriter 4500

Macintosh
Macintosh
Color
Color

StyleWriter 4500

Color
StyleWriter 4500



Appendix D
Using ColorSync

Mac OS-based computers use ColorSync to help make sure that the colors
you see on your monitor closely match the colors you get on your printers,
scanners, and other devices Because ColorSync works behind the scenes, you
dorit have to know anything about it. All you need to do isinitially set it up.
This appendix describes how ColorSync works and how to configure your
monitor and computer to take advantage of it.

The problem that ColorSync solves

Providing consistent color with desktop computers is a technical challenge
because different color devices use different methods for representing color,
and they produce different ranges of colors. For example, the colored light on
your monitor is very different from the colored inks your printer uses.

Different color devices also create color using different methods Monitors
(and most scanners) produce colors by mixing red, green, and blue light—
called RGB color. Most printers produce colors by mixing cyan (a shade of
blue), magenta (a bright pink), yellow, and black ink. This color system is
called CMYK. Since monitors, printers, and scanners each have different color
capabilities, they cannot reproduce each other’s colors exactly.
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Further compounding the problem is that no two monitors or printers
produce exactly the same colors (For example you can see differencesin
color ability among monitorsin the TV department of a consumer
electronics store)

ColorSync is a system extension that provides color-conversion capabilities
and improves color consistency. ColorSync “trandates’ the colors used on one
device so that they more closely match the colors displayed or printed on
another device

ColorSync color conversion is acentral part of Mac OS-based computing,
ensuring that applications, monitors, printers, scanners, and digital cameras
can use the same scheme for color converson. This means you can scan an
image, display it on your monitor, and print it—with visually matching colors
every step of the way.

How ColorSync works

Appendix D

When you create a TIFF or PICT file usng a program that supports
ColorSync, a“profilé’ describing the color capabilities of your equipment is
saved with the image For example, when you scan a photograph, a profile
describing the scanner is saved inside the image file If you later print the
image, even using a different computer, ColorSync looks at the profile to learn
about the capabilities of the scanner you used, and automatically picks closely
matching colors that your printer can reproduce

The profile contains information ColorSync needs to perform color matching,
such as the lightest and darkest possible tones (white point and black point)
that the device can produce, and the maximum supported densities for red,
green, blue, cyan, magenta, and yellow. Together, these characteristics
describe the color gamut (or range) that a device is capable of capturing,
displaying, or reproducing. To take advantage of ColorSync, each of the
imaging devices you use needs to have its own ColorSync profile When you
create images using these devices, information from the profile will
automatically become part of the image file—ensuring that colors are
consistent throughout the entire creative process.



Because ColorSync information becomes part of your output files, you dorit
have to worry about losing the profile or using the wrong profile with the
wrong image Additionally, ColorSync profiles are in the standard
International Color Consortium (ICC) format recognized by Microsoft
Windows, Mac OS and other systems.

When you work with an image that has an embedded ColorSync or ICC
profile, ColorSync identifies the colors that your monitor or printer can
reproduce by examining their ColorSync profile It compares their capabilities
with those of the system used to create the image (as described in the
embedded profile), and then picks appropriate, matching colors. For example,
your monitor may be able to display avivid red, but your printer inks may not
be able to produce that color. ColorSync determines the “next best” color for
your printer to use

Monitor Printers
LTI
| 1
mmmmm V. ColorSync profile v
.. ..‘
\ R4

Digital cameras Scanners

ColorSync performs color matching by comparing each profile to an
independent color standard. ColorSync uses the CIE color standard, which
describes colors in terms of how they are perceived by the human eye under
specific lighting conditions. (CI E stands for the Commission International de
I'Eclairage, the International Commission on Illumination, which created the
standard in 193L)
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Setting up ColorSync
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To take advantage of ColorSync, you need to obtain profiles for each of your
imaging devices, such as your monitor, scanner, and color printer. ColorSync
profiles are usually automatically installed when you install the software for a
ColorSync-supported device Profiles are stored in the ColorSync Profiles
folder, insde Preferences in the system folder. If you need to obtain a
ColorSync profile, contact the manufacturer of your device Ask for either a
ColorSync or ICC profile for the specific model of monitor, printer, or
scanner youre using.

You also need to make sure the ColorSync extension and Apple CMM 2 are
installed and active. ColorSync is automatically installed in the Extensions
folder of your system folder during software installation. Unless youve
removed or disabled it, it's already installed.

Finally, you need to set a ColorSync System Profile for the Mac OS The
ColorSync System Profile is used by ColorSync to determine the color range
of your monitor. ColorSync compares this information with the profiles of
your other devices to make sure that colors are consistent with what you see
on your monitor.

Additionally, the System Profile is used as a default profile if a document you
are working on doesnit have any ColorSync information saved within it. This
can occur if the document was created without ColorSync installed. By using
the System Profile as a default, ColorSync ensures that colors are consistent
with what you currently see on your monitor.

For the best color on your Color StyleWriter 4500 printer, you need to choose
a specific profile for your monitor. In the ColorSync control panel, choose the
D50 prafile for your monitor. If there is no D50 available for your monitor,
choose Apple Multiple Scan 17 — D50. The D50 profile gives you better
“warm’ colors



For the best visual match between the colors on your monitor and printed
colors, select the Page-White Gamma option in the Monitors control panel.
(On some computers, this may be called the Monitors & Sound control
panel.) To select a gamma option, open the Monitors control panel, then hold
down the Option key while you dick the Options button. In the Options
window, click the Use Special Gamma checkbox to put a check init. Then
choose Page-White Gamma from the menu.

On a multiscan monitor, make sure that the color temperature, or intensity, is
set to 9300 K (the default setting). See the monitor manual for instructions. If
you select the Page-White Gamma option with a color temperature other than
9300 K, your monitor colors could look too red or too blue compared to
printed colors.

Setting the ColorSync System Profile
To set the System Profile, follow these steps:
Make sure the profile you want to use is located in the ColorSync Profiles folder.

This folder islocated in the Preferences folder in your System Folder.

Choose Control Panels from the Apple (8) menu and open the ColorSync System Profile
control panel.

The ColorSync System Profile control panel appears.

SO=——— ColorSync™ = |
2.1
[ﬂ Set Profile...

Applettizion 850 - 9300

Click Set Profile.

A dialog box appears with alist of ColorSync profiles installed on your
computer.

Using ColorSync
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Click the profile you want to use.

Select New System Profile:

|ﬁ] Colorsync™ Profiles "I =— Mac HD 80

Apple Multiple Scan 15
Apple Multiple Scan 17 - 9300
Apple Multiple Scan 17 - D50
Apple Multiple Scan 17 - D65
Apple Multiple Scan 1705
Apple Multiple Scan 20 - 9300
Apple Multiple Scan 20 - D50

Cancel

i

Select

Apple Multiple Scan 17 - 050

Select the D50 profile for your monitor, or Apple Multiple Scan 17 D50 if you
cant find a D50 profile for your monitor.

Click Select.

ColorSync automatically references the profile you selected and usesit to
define the color capabilities of your monitor.

Close the ColorSync System Profile control panel.

Setting other ColorSync profiles

Some programs and printer software might require that you do something
special, such as turning on an option, in order to take advantage of ColorSync.
For example, to use ColorSync with the Apple Color OneScanner, select the
Use ColorSync option in the ColorSync Preferences dialog box of the
OneScanner Dispatcher software This tells the scanning software to embed
information about the Color OneScanner in scanned images.

Refer to the instructions that came with your application or device to
determineif it supports similar options. If therés an option to specify a
profile or to activate ColorSync, be sure to use it.



Tips for best results

After youve made sure ColorSync isinstalled, set the System Profile, and set
any necessary ColorSync options for your applications, youre ready to begin
taking advantage of ColorSync! Just scan, create, and print your images or
documents as you normally would. ColorSync works behind the scenesto
ensure congstent color matching.

The following settings and strategies will help you get the best color results
from your system. Not all of these tips will apply to the software and devices
you may be using, but be sure to take advantage of those tips that do.

Set the gamma curve for your monitor to 18;Standard to have the monitor
more closely match printed results.

Use the ColorSync System Profile control panel in the Apple (&) menu to
select the D50 profile for your monitor, or Apple Multiple Scan 17-D50 if
you carit find a D50 profile for your monitor. If you calibrate your monitor,
you can create a custom profile and select it as the system profile instead.
See the documentation that came with your monitor for more information
on creating custom ColorSync profiles.

When printing in color, check to seeif the printing optionsinclude a
setting for ColorSync. For example, for the Apple LaserWriter 12/600 PS
turn on ColorSync by dicking the Options button and selecting “ ColorSync
Color Matching”

If your scanning program has a ColorSync option, use it. This embeds a
ColorSync profile within the scanned image file, and ColorSync will be
better able to reproduce the original colors on your monitor and printer.

Dorit try to use two color-matching systems at once on your computer.
Some applicationsinstall other color-matching systems. These should
either be removed or disabled if you want to use ColorSync.

Using ColorSync ' 115



For more information
To learn more about ColorSync, or color matching and color technology in
general, refer to these publications and resources.
Publications

Advanced Color Imaging on the Mac OS Apple Compulter, Inc.,
Addison-Wed ey Developers Press, ISBN 0-201-48949-X

ColorSync 20 White Paper at gopher://info.applecom

Internet Resources

Apple Imaging Web Ste at http://imaging.applecom

Apple Technical Information Library at http://til .info.applecom
International Color Consortium at http://www.color.org

ColorSync plug ins for use with Adobe Photoshop (Macintosh Utilities
section of the Apple Software Updates page on the Apple Support and
Information Web at http://www.info.apple.com)
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A

A4 paper 13,91
AC power adapter 3, 92
Adobe PostScript font icon 98
Adobe Type Manager 79, 98, 100, 106
alcohol-based or ammonia-based
cleaners 2, 63
alias for adesktop printer icon,
creating 40
Align Top Left watermark scaling
option 35, 36
Apple-authorized deal er/service provider
obtaining ink cartridges
and supplies 58
purchasing new system software or
memory 15
repair assistance 65
waste ink container isfull 77
Appleclassic fonts 107
Apple menu, Turn Desktop Printing
Off 123
Apple part numberslist 93-94
Apple System/Peripheral-8 cable
3,90, 93
AppleTalk network, sharing the printer
4446
Application menu, PrintMonitor
command 128
audio alert of print completion 30

¢

Can't Find It? See also Macintosh Guide’s
onscreen index. Open the Guide (@)
menu and choose Macintosh Guide;

then click the Index button.

B

background printing
low memory and 78, 79
monitoring and controlling 42—43
PrintMonitor and 128
QuickDraw GX and 115
turning on or off 41
working with 28, 31
back-print film
backwards printing and 81
loading into the sheet feeder 26,
51,75
print quality setting for 120
tipsfor using 51
Best print quality option 30, 52, 119, 120
bitmapped font icon 97
bitmapped fonts
Appleclassic fonts 107
described 97
PostScript and 98
TrueType and 99-100, 106
Bitstream PostScript font icon 98
black ink cartridge
printing speed and 53
vs. color ink cartridge 4
when to replace 58
borders around mini pages 29, 37
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Can't Find It?

See also Macintosh

Guide’s onscreen index.

Open the Guide (@)
menu and choose
Macintosh Guide; then

click the Index button.

Index

cables
Apple System/Peripheral-8 3, 90, 93
checking connections 70
LocaTak 11
network 11
serial 11
“carbonless carbon” paper 49, 82
carrier
handling of 7-8, 10
replacing the ink cartridge and 59, 61
Centered watermark scaling option
35, 36
changing the order of itemsto print,
background printing and 43
Chooser
changing the default printer 39
selecting the printer 17, 28
setting up the printer for network use
45-46
setting up the printer for QuickDraw
GX 115117
turning background printing on or
off 41
user instructions for a shared
printer 47
Chooser dialog box 17, 115-117
CIE color standard 113
cleaning
the printer 2, 63, 87
the print head 30, 84-85, 122
CMYK color system 111
coated paper 26, 50, 119
color ink cartridge
vs. black ink cartridge 4
when to replace 58
color matching, turning on 32-33
color options, adjusting 30, 32—33
Color Options dialog box 32-33, 52
color printing
quirks 33
troubleshooting 82, 84

ColorShare 42, 44, 85
Color StyleWriter 2500 Disk 1 14,
68, 125
Color StyleWriter 2500 icon 16, 17,
31, 66
Color StyleWriter 2500 Log file 46
Color SW 2500-Troubleshooting file
19-20. See also test page
ColorSync
control panel 32, 113, 121
described 111-113
profiles 32, 112, 113, 121
turning on 32-33, 52
columns, printing, troubleshooting 81
connecting the printer
touseonalocalTalk or EtherTalk
network 48
to use on an AppleTak network
44-46
to use with QuickDraw GX 115-117
to your Macintosh 11
Connect via pop-up menu (Chooser
dialog box) 115-116
controlling print requests. See monitoring
and controlling print requests
control panels
ColorSync System Profile 32,
113,121
Monitors 113
copies, selecting number to print 30
cost of printing, reducing 53
creating a desktop printer icon 40
Custom Install dialog box 69
Custom Install option 16, 68-69
Custom Remove dialog box 126
Custom Remove option 126-127



D

damaged paper 49, 74-75, 82
default desktop printer icon 38, 40
default printer, changing 38-39
deleting a print request, background
printing and 42
density of watermarks 35, 36
desktop printer
creating 17, 40, 116
formatting a document for,
QuickDraw GX 118
desktop printer icons
appearance after removing desktop
printer software 127
creating, throwing away, or
manipulating 40
examplesof 16, 31
troubleshooting 71
desktop printing 31
low memory and 78
turning off QuickDraw GX 123
desktop printing software, removing
125-127
Desktop PrintMonitor 79
dialog boxes
Chooser 17, 115-117
Color Options 32-33, 52
Custom Install 69
Custom Remove 126
Installer 15, 68, 126
Page Setup 19, 29, 37, 80, 117
Page Setup, expanded QuickDraw GX
version 118
Print 20, 30, 52, 85, 119
Print, expanded QuickDraw GX
version 120-122
PrintMonitor 128
Setup 45
Utilities 85
Watermark Options 35
dimensions of printer 91
disabled (X) desktop printer icon 40,
71, 127

disconnecting the printer. See unplugging
the printer

disks, locking 14

display fonts 106

distorted print output, troubleshooting 87

document icon 31

downloadable fonts 108

Draft print quality option 30, 53,
119, 120

E

electromagnetic interference 4
energy-saving feature 6
engine specifications of the printer 89
enlarging the printed image. See scaling
envelopeicon 24, 25
envelopes
feed improperly 74-75
formatting the text for 26, 27
loading into the sheet feeder 24, 75
setting the paper selectorsfor 24, 25
typesto use 26, 77, 90, 91
environment specifications 92
erasable typing paper 49, 82
error light 6, 21, 72
error messages 70, 77
EtherTalk network, connecting the
printer to 48
extensions, turning off 14
external paper selector lever 13, 24

features of the printer, overview ix
File menu
Page Setup command 19, 23, 29,
34-37,117-118
Print command 20, 27-28, 30-33, 38,
119-122
Quit command 20
Save command 33

Index
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Can't Find It?

See also Macintosh

Guide’s onscreen index.

Open the Guide (@)
menu and choose
Macintosh Guide; then

click the Index button.

Index

filling the sheet feeder. See loading the
sheet feeder
fixed-size fonts 97
folders
Fonts 67, 102, 106
font suitcases 103-104
Printing Prefs 37, 46, 81
Fontek PostScript font icon 98
font families 109-110
fonts
Appleclassic fonts 107
bitmapped 97, 99-100, 106
corrupted, resolving installation
problems 66-69
displaying in the Fonts menu 106
downloadable 108
Geneva appears as a substitute
font 107
how the Macintosh looks for 101
installing 14
list of 109-110
low memory and 107
making purchasing decisions 106
naming 100
organizing in suitcases 103-104
PostScript 98, 100, 106
QuickDraw GX 98
search order 101
storing on the computer 102-104
stylesfor 105
supported by the printer 90, 95,
109-110
TrueType 96-97, 99-100, 106
used for display 106
viewing on-screen 96-97
Fonts folder 102, 106
removing items from 67
Fonts menu 106
font styles 105
font substitution 107, 108
font suitcases 102-104
four-color ink cartridge. See color ink
cartridge
future print time, setting 43

G

Get Info command 78
glossy paper 26, 50, 82, 120
guide. See paper guide

H

halftoning method, selecting 32, 38,
52,121
hardware requirements x

high-performance black ink cartridge. See

black ink cartridge
holding a print request, background
printing and 43
horizontal orientation. See
landscape orientation
horizontal white lines appear on
the printed page,
troubleshooting 84
humidity range for the printer 92

icons
bitmapped font 97

Color StyleWriter 2500 16, 17, 31, 66

Color SW 2500-Troubleshooting
file 19

default desktop printer 38, 40

desktop printer 16, 31, 40, 71, 127

disabled (X) desktop printer 40,
71, 127

document 31

envelope 24, 25

modem port 11, 18

paper 24,25

PostScript font manufacturers 98

printer error 40

printer port 11, 18

printing 40

stopped print queue 40

image print option
low memory and 78
selecting 30, 119, 121



ink
checking if the printer isout of ink 76
reducing the amount used 53
smears when rubbed,
troubleshooting 83
ink cartridges
extending the life of 88
installing 7-10
part numbersfor 93
preventing from drying out 4, 6, 62
replacing 58-61
storing 4, 62
switching 53
troubleshooting 76
unpacking 3
ink cartridge storage case 3, 4, 62
ink tanks
extending the life of 88
part numbersfor 93
replacing 55-57
safety instructions for 66
troubleshooting 76
ink waste container 77
inserting paper into the sheet feeder. See
loading the sheet feeder
installation problems, troubleshooting
6669
Installer dialog box 15, 68, 126
Installer program 14-16, 68—69,
125127
installing
fonts 14
ink cartridges 7-10
printer software 14-16, 68—69
QuickDraw GX software 14
interface specifications of the printer 90
interference with television and radio
reception vi
internal modem on PowerBook
computers 11, 17, 18, 70
internal paper selector lever 12, 25, 87

J

jagged edges on printed output 96, 97
jammed or damaged paper, removing
73,75

K
Key Caps desk accessory 97

L

labels 26
landscape orientation
low memory and 78
setting 29, 117, 118
layout, adjusting 29
Layout pop-up menu (Page Setup dialog
box) 37
legal-size paper 13, 25
letterhead paper 24
letter-size paper 13, 27-28
lights on the printer 6, 21, 72
liquid cleaners 63
liquid spillsin the printer 2
loading the sheet feeder
with back-print film or transparencies
26,51, 75
basic instructions 12-13, 24-25
with envelopes 24, 26, 75
with labels 2, 26
with various kinds of paper 26, 49-50
LocalTalk cable 11
Local Tak network, connecting the
printer to 48
location for the printer, choosing 4
locking disks 14
log file for printer usage 46

Index
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Can't Find It?

See also Macintosh

Guide’s onscreen index.

Open the Guide (@)
menu and choose
Macintosh Guide; then

click the Index button.

Index

M

maintenance tasks. See also safety
instructions
cleaning the printer 2, 63, 87
replacing ink tanks 55-57
replacing the ink cartridge 58-61
storing a second ink cartridge 62
Matching Method pop-up menu (Color
Options dialog box) 33
memory
low memory indications and
suggestions 78-79
required for the printer x
virtual memory 4, 79
messages on-screen 70, 77
mini pages (2 or 4), printing 29, 37
modem port 11, 17, 18
moi sture exposure to the printer 2
monitoring and controlling print requests
with background printing on 42—43
on anetwork printer 47
without desktop printers 128
Monitors control panel 113
moving a desktop printer icon 40
moving a print request to another printer,
background printing and 43
moving the printer along distance
129-130
multipart forms 49, 82

N

naming
fonts 100
font suitcases 104
network cable 11
networks
AppleTalk 44-46
LocalTak or EtherTalk 48
network zones 47, 116
non-standard documents, printing 28-31

Normal print quality option 30, 53,
119, 120

notification of print completion,
selecting 30

nozzle test pattern, interpreting 22, 86

number of copiesto print, selecting 30

0

opening the printer 7, 25, 56, 59, 87
operating environment specifications 92
orientation

low memory and 78

setting 29, 117, 118
output tray, opening 13, 25

P

packing the printer 129-130
page breaks, change unexpectedly,
troubleshooting 80
Page Setup command (File menu) 19,
23, 29, 34-37, 117-118
Page Setup dialog box 19, 29, 37,
80, 117
expanded QuickDraw GX
version 118
page setup options. See also print options
setting 23, 29, 34-35, 37, 117-118
page size, adjusting 29, 117
pages to print, selecting 30
paper. See also print materials
jammed or feeding improperly 73-75
loading into the sheet feeder 12-13,
24-25,75
saving 37
sizes supported 91
types not to use 49, 82
typesto use 26, 49-50, 77, 82, 90
paper guide, adjusting 13, 24, 75
paper icon 24, 25
paper-matching feature, QuickDraw
GX 120



paper selector lever
external 13, 24
internal 25, 87
paper support, extending 13, 24
paper type, indicating 30, 77, 118,
119,121
part numberslist 93-94
password for network printer usage
45, 47
Pattern halftoning option 32, 38, 83
PICT/PICT2 format files, watermarks
and 36, 81
pictures do not print, troubleshooting 80
pixels 96
plain paper
tipsfor using 49
troubleshooting 82, 83
weight recommended 26, 49, 90
platen, cleaning 63, 87
plugging in the printer 5
portrait orientation
low memory and 78
printing in 27
setting 29, 117, 118
ports
changing the selection 70
modem and printer 11, 17, 18
seria, PowerBook computers 18
PostScript fonts
described 98
downloadable 108
TrueTypeand 100, 106
PostScript page description language 79,
80, 98
power adapter 3, 92
PowerBook computers
internal modemsand 11, 17, 18, 70
selecting the correct system profile for
ColorSync 32,121
power button 6, 21, 72
power consumption specifications 92
power light 6, 21, 72

Power Macintosh computers, virtual
memory and 4
power requirements for AC power
adapter 92
power-saving feature 6
power strip, turning off 6
precautions. See maintenance tasks;
safety instructions
premium coated/premium plus coated
paper 26, 50, 90
printable area 91
Print command (File menu) 20, 27-28,
30-33, 38, 119122
Print dialog box 20, 30, 52, 85, 119
expanded QuickDraw GX version
120122
printer error icon 40
printer log file 46
printer port 11,17, 18
Printer Profile pop-up menu (Color
Options dialog box) 33
printer software
installing 14-16, 68-69
removing 125-127
print head
cleaning 30, 84-85, 122
handling of 8-9, 59
preventing from drying out 4, 6, 62
troubleshooting 83, 84, 86
printing. See also background printing;
desktop printing;
troubleshooting
adjusting color options 30, 32-33
back-print film 26, 51, 75, 81, 120
borders around mini pages 29, 37
color printing quirks 33
the Color SW 2500-Troubleshooting
file 19-20
envelopes 24, 25, 26, 27, 74-75
labels 26
in landscape orientation 29, 117
legal-size paper 13, 25
letterhead paper 24

Index
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Can't Find It?

See also Macintosh

Guide’s onscreen index.

Open the Guide (@)
menu and choose
Macintosh Guide; then

click the Index button.

124 Index

mini pages (2 or 4) 29, 37
non-standard documents 28-31
on ashared printer 47
on various paper finishes 26
in portrait orientation 27-28, 29, 117
previously formatted documents 31
with QuickDraw GX 115-122
reducing cost of 53
scaled documents 29, 34, 117, 118
selected pages of adocument 30
several documents at once 31
specific number of copies 30
standard documents 2728
atest page 19-20, 56, 59, 84, 86
three-hole punched paper 24
transparencies 26, 51, 75, 120
troubleshooting 69-88
U.S. letter-size paper 27-28
utilitiesfor 30
watermark images 29, 34-37
while using your computer 41-43
without leaving the Finder 31
printing icon 40
Printing menu, Set Default Printer
command 39
Printing Prefsfolder 37, 46, 81
print materials. See also back-print film;
envelopes; paper; transparencies
part numbersfor 93
standard and non-standard, printing
2731
tipsfor choosing 49-51
typesto use 24, 26, 90-91
PrintMonitor command (Application
menu) 128
PrintMonitor dialog box 128
PrintMonitor program
changes to printing software and x
using if you don’'t have desktop
printers 128
print nozzles, checking 21-22
print options. See also page setup options
setting 30, 3233, 39, 119-122

print quality
for greater speed 53
QuickDraw GX printing and 119,
120, 121
selecting 30, 52
troubleshooting 82-87
print queue
removing requests from 79
working with 4243
print requests
deleting multiple requests for a
document 70
monitoring and controlling 4243,
47,128
removing 79, 128
scheduling 120, 128
print time, setting, background printing
and 43
profiles, ColorSync 32, 112, 113, 121
proportional space numerals 106

Q

quality options. See print quality
QuickDraw GX
background printing and 41
cleaning the print head 122
expanded Page Setup dialog box 118
expanded Print dialog box 120-122
font features 98
installing 14
network printing and 44, 70
page setup definition 117-118
printing with 119-122
setting up the printer for use with
115117
turning off 123
typographic features of 106
Quit command (File menu) 20



R

radio and television reception,
interference with vi
RAM. See memory
Read Mefile 32
reducing the printed image. See scaling
removing
desktop printing software 125-127
jammed or damaged paper 73, 75
renaming
a desktop printer icon 40
anetwork printer 48
repacking the printer 129-130
replacing
theink cartridge 5861
ink tanks 55-57
resetting the printer 71
resolution
of bitmapped fonts 7
specifications of the printer 89
Restart command (Special menu) 14
restarting the computer with extensions
turned off 14
RGB color system 111
rollers, cleaning 63, 87
rotated text, troubleshooting 79

S

safety instructions 1-2, 6, 66. See also
maintenance tasks
Save command (File menu) 33
saving
energy 6
paper 37
scalable fonts 96, 97, 100
scaling
adjusting 29, 34,117, 118
of watermarks 35, 36
Scatter halftoning option 32, 38, 52
screen fonts 97
serid cable 11

serial port on PowerBook computers 18
Set Default Printer command (Printing
menu) 39
Setup dialog box 45
shared printers
cleaning the print head and 85
print requeststo 42
setting up 44-48
troubleshooting 70, 79
user instructionsfor 47
sheet feeder
capacity of 12, 26, 74, 90
loading 12-13, 24-26, 49-51
troubleshooting 7375
unpacking 3
size of printer 91
software disks, unpacking 3
software requirements x
sorting items waiting to print,
background printing and 43
Specia menu, Restart command 14
speed of printing, increasing 53
stains on printed pages,
troubleshooting 87
standard documents, printing 27-28
stapled paper 49
stopped print queueicon 40
stopping items temporarily from printing,
background printing and 43
storage case for ink cartridge 3, 4, 62
storage environment specifications 92
Stretch to Fit watermark scaling option
35, 36
stripes appear on the printed page,
troubleshooting 84
stylesfor fonts 105
suitcases for fonts 102—104
swash characters 106
switching between printers 38-39
system profile, ColorSync and 32, 112,
113,121
system requirements x

Index

125



rs

Can't Find It?

See also Macintosh

Guide’s onscreen index.

Open the Guide (@)
menu and choose
Macintosh Guide; then

click the Index button.
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T

technical specifications of the printer
89-91
television and radio reception,
interference with vi
temperature range for the printer 92
test page, printing 19-20, 56, 59, 84, 86
test pattern for print nozzles, interpreting
22,86
three-hole punched paper 24
throwing away a desktop printer icon 40
transparencies
loading into the sheet feeder 26, 51,
75
print quality setting for 120
tipsfor using 51
troubleshooting
cable connections 70
color printing quirks 33
colorsdon’t look right 84
colors skip or streak at the bottom of
the page 82
Color SW 2500 icon doesn’t appear in
the Chooser 66
columns are misaligned when
printed 81
computer crashes while attempting to
print 69
corrupted fonts 6669
deleting multiple print requests 70
error light indicates a problem 72
horizontal white lines appear on the
printed page 84
ink cartridges and tanks run out of ink
too quickly 76, 88
ink smears when rubbed 83
installation is unsuccessful 66-69
jagged text 79
lines fade or break up 83
low memory indications and
suggestions 78-79

message states that no Color
StyleWriter 2500 is connected
70-71
nothing prints 70-71, 76
nozzlesin print head 83, 84, 86
page breaks change unexpectedly 80
paper isjammed or feeds improperly
73-75
aparticular document won't print 76
pictures do not print 80
port selection 70
PowerBook computers 70, 71
power light indicates a problem 72
printer ssemsslow 73
printer softwareinstallation 16, 70
printing appears on only part of the
paper 84
printing is backwards 81
printing is off center 80
printing is smeared, blurred, or
smudged 83
printing istoo light or too dark 83
print quality 82-87
resetting the printer 71
rotated text printsjagged 79
shared printers 70, 79
stains on printed pages 87
stripes appear on the printed page 84
text printsin Genevafont 79
watermark problems 81
wavy or distorted print output 87
TrueType fonts
bitmapped fontsand 99-100, 106
described 96-97
downloadable 108
PostScript fontsand 100, 106
Turn Desktop Printing Off (Apple menu)
123
turning the printer on and off 6
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unpacking the printer 34

unplugging the printer 2, 5, 6, 63, 66

urgent print requests, background
printing and 43

U.S. letter-size paper 13, 27-28

Utilities dialog box 85

utilities options to clean the print head

30, 85, 122

vV

vertical orientation. See portrait
orientation

virtual memory
low memory condition and 79
Power Macintosh usersand 4
visual aert of print completion 30

W, X, Y

warranty on the printer 55, 65
waste ink container 77
Watermark Options dialog box 35
watermarks
creating your own 36-37
low memory and 78
scaling 35, 36
specifying 29, 34-35
troubleshooting 81
wavy print output, troubleshooting 87
weight of printer 91
weight recommended for paper 26, 49,
82, 90
white lines appear on the printed page,
troubleshooting 84
wrinkled paper 49

VA

zones, network 47, 116

Index

127



«

v

=3

Color StyleWkiter 4500

Color ink-jet printer for Mac OS users




& Apple Computer, Inc.
© 1997 Apple Computer, Inc. All rights reserved.

Under the copyright laws, this manual may not be copied, in whole or in part, without the
written consent of Apple. Your rights to the software are governed by the accompanying
software license agreement.

The Applelogo is atrademark of Apple Computer, Inc., registered in the U.S. and other
countries. Use of the “keyboard” Apple logo (Option-Shift-K) for commercia purposes without
the prior written consent of Apple may constitute trademark infringement and unfair
competition in violation of federal and state laws.

Every effort has been made to ensure that the information in this manual is accurate. Appleis
not responsible for printing or clerical errors.

Apple Computer, Inc.

1 Infinite Loop

Cupertino, CA 95014-2084

408-996-1010

http://www.apple.com

http://imaging.apple.com

Apple, the Apple logo, AppleShare, AppleTak, AppleVision, Chicago, ColorSync,
LaserWriter, Loca Talk, Mac, Macintosh, Macintosh Quadra, New Y ork, PowerBook, Power
Macintosh, StyleWriter, and TrueType are trademarks of Apple Computer, Inc., registered in
the U.S. and other countries.

Extensions Manager, Finder, Geneva, Monaco, OneScanner, and QuickDraw are trademarks of
Apple Computer, Inc.

Adobe, Acrobat, Adobe Illustrator, Adobe Type Manager, Photoshop, and PostScript are
trademarks of Adobe Systems Incorporated or its subsidiaries and may be registered in certain
jurisdictions.

Classic is aregistered trademark licensed to Apple Computer, Inc.

Helvetica, Palatino, and Times are registered trademarks of Linotype-Hell AG and/or its
subsidiaries.

ITC Avant Garde, ITC Bookman, ITC Garamond, I TC Lubalin Graph, ITC Machine, ITC Zapf
Chancery, and I TC Zapf Dingbats are registered trademarks of International Typeface
Corporation.

Other products and company names mentioned herein may be trademarks of their respective
companies. Mention of third-party productsis for informational purposes only and constitutes
neither an endorsement nor a recommendation. Apple assumes no responsibility with regard to
the performance or use of these products.

Simultaneously published in the United States and Canada.



Contents

Communications regulation information i
Welcome  ix

1 Setting Up Your Printer 1
Important safety instructions 1
Unpacking the printer 3
Plugging inthe printer 5
Connecting the printer directly to your computer 6
Connecting to aLocal Talk network (optional) 7
Turning the printer on and off 8
Power Macintosh users and virtual memory 8
Installing theink cartridges 9
Installing your printer software 12

Telling your computer to use a directly connected
Color StyleWriter 4500 16

Telling your computer to use a Color StyleWriter
onalocaTak network 17

Loading paper into the paper tray 19
Aligning theink cartridges 21
Printing the samplepage 23
Usngonscreenhelp 24



iv

Contents

2 Printing 27

Planning documents with the Color StyleWriter 4500 in mind
Printing adocument 28

Printing while you use your computer 3L
Monitoring and controlling background printing 32
Adjusting color options 33

Printing a photograph 34

Printing abanner 38

Printing envelopes 42

Printing tranparencies 47

Printing labels 49

Printing index cards and postcards 5L

Manual duplex printing (two-sided) 54

Printing a flipped document 56

Defining your own custom paper szes 57
Switching between printers 58

Tips on Paper, Quality, Speed, and Cost 61
Choosing print materials 61

Quality 65
Speed 66
Cost 66

Maintaining Your Printer 67
Replacing ink cartridges 68
Cleaning the outside of the printer 68

27



5 Troubleshooting 69

Appendix A
Appendix B
Appendix C
Appendix D

Safety precautions 70

The Chooser doesrt show the Color SW 4500 icon 70

Installation is unsuccessful 70

The computer crashes while attempting to print 72

The computer doesrit recognize the Color StyleWriter 4500 72

A PowerBook has trouble printing to the Color StyleWriter 4500 73
Thelightsindicate aproblem 74

The printer seemsdow 75

Paper isjammed 76

Paper or envelopes feed improperly 76

The Color StyleWriter 4500 worlt print a particular document 77
The printer acts asif it's working, but nothing is printed on the page 77
M essages appear on your computer screen 78

Memory islow 78

Documents did not print as expected 79

Print quality ispoor 8L

Ink cartridges run out of ink too quickly 85

Technical Information 87

Using Fonts With the Color StyleWriter 4500 93
Font List 107

Using ColorSync 109

Index 117

Contents



vi

Communications regulation information

FCC statement

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. Seeinstructionsif interference to
radio or television reception is suspected.

Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If itisnot installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specificationsin Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in aresidential installation. However,
there is no guarantee that interference will not occur in a particular installation.

Y ou can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:

= Turnthetelevision or radio antenna until the interference stops.

= Movethe computer to one side or the other of the television or radio.

= Movethe computer farther away from the television or radio.

= Plug the computer into an outlet that is on adifferent circuit from the television or radio.
(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions.

IMPORTANT Changes or modificationsto this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

Use of ashielded cableis required to comply within Class B limits of Part 15 of FCC Rules.

Communications Regulation Information



Industry Canada statement

This Class B device meets al requirements of the Canadian Interference-Causing equipment
regulations.

Cet appareil numérique de la Class B respecte toutes | es exigences du Reglement sur |e matériel
brouilleur du Canada.

VCCI Class 2 statement
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Welcome

Congratulations on your purchase of the Apple Color StyleWriter 4500
printer. This book describes how to set up the printer and how to useit.

Main features of the Color StyleWriter 4500
The Color StyleWriter 4500 works with most Mac OS-based computers.

The Color StyleWriter 4500 prints high-quality color graphics and text on
avariety of materials, including plain paper.

Along with the printer, you have everything you need to print amazingly
photorealistic images—right from your desktop. Thisisideal for printing
scanned images, images from photo CDs, and graphics from the Internet.

The automatic sheet feeder holds up to 100 sheets of paper, up to 20
envelopes, and 20 sheets of continuous banner paper.

You can connect the printer o a Local Talk network or connect it directly to
your computer with a serial cable

35 available TrueType (outline) fonts print smoothly in a variety of sizes



System requirements
To install the printer software and use the Color StyleWriter 4500 printer with
your Mac OS-based computer, you need

s aMac OS-based computer with a 68030/33 MHz or higher central
processing unit (CPU), any Macintosh model except a Macintosh Plus, 11,
SE, llg, llci, Classic®, Portable, or PowerBook 100

= Macintosh Operating System (Mac OS) version 71 or alater verson

= at least 4 megabytes (MB) of random-access memory (RAM) for anon-
Power Macintosh; if you have a Power Macintosh, 8 MB of RAM isthe
minimum requirement, and 16 MB is recommended

= at least 8 MB of space available on your hard disk for the printer software

The Installer program that comes with the Color StyleWriter 4500
automatically checks whether your computer meets these requirements.
Chapter 1 explains how to use the Installer program.
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